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Tutorial Outline

Time (Tentative!) Module Outcomes Presenter

8:30-8:35 1. Overview of Eclipse + Introduction to Eclipse/PTP Greg
and PTP

8:35-8:50 2. Installation Prerequisites Greg

Installation

8:50-9:20 3. Working with C/C++ Eclipse basics Beth
Creating a new project

Building and launching

CVS, Makefiles, autoconf, PLDT MPI tools
Resource Managers
Launching a parallel application

9:20-10:50 4. Working with MPI

+
+
+
+
+
+
+
+

10:00 - 10:30 Break
10:50-11:10 5. Fortran

Photran overview
MPI project creation
Differences from CDT

11:10-11:30 6. Debugging Introduction to parallel debugging Greg

Debugging an MPI program

11:30 - 11:50 7. Advanced Features Perspectives, Views, Preferences, Team Jeff/Beth
Refactoring/Search (Fortran & C/C++)
PLDT (MPI, OpenMP, UPC tools)

Remote Development

+l++++|+ ]|+ ++

11:50- 12:00 8. Other Tools, Wrapup NCSA HPC WB, Perf and other Tools, Jay/Beth

website, mailing lists, future features
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Module 1: Introduction

+ Objective
+ To introduce the Eclipse platform and PTP

+ Contents
+ What is Eclipse?
+ What is PTP?

Module 1
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What is Eclipse?

+ A vendor-neutral open-source workbench for
multi-language development

+ A extensible platform for tool integration

+ Plug-in based framework to create, integrate
and utilize software tools

Java C/C++/Fortran Test and
Development Development Performance Parallel Tools
Tools Tools Tools

Platform

User

Module 1
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Eclipse Platform

+ Core frameworks and services with which all
plug-in extensions are created

+ Represents the common facilities required by
most tool builders:
+ Workbench user interface
+ Project model for resource management
+ Portable user interface libraries (SWT and JFace)

+ Automatic resource delta management for
incremental compilers and builders

+ Language-independent debug infrastructure

+ Distributed multi-user versioned resource
management (CVS supported in base install)

+ Dynamic update/install service

Module 1
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Plug-ins

Java Development Tools (JDT)

Plug-in Development Environment (PDE)
C/C++ Development Tools (CDT)

Parallel Tools Platform (PTP)

Fortran Development Tools (Photran)

Test and Performance Tools Platform (TPTP)
Business Intelligence and Reporting Tools (BIRT)
Web Tools Platform (WTP)

Data Tools Platform (DTP)

Device Software Development Platform (DSDP)
Many more...

+
+
+
+
+
+
+
+
+
+
+
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Eclipse Parallel Tools Platform (PTP)

Coding & Analysis Launching & Monitoring

S Make - test.c - Eclipse SDK

Fie
F-0-%- | m®

= 0)([@ manc
UNALLOCATED

ALLOGATED TO YOU EXCLUSIVELY, BUT DLE
ALLOCATED TO YOU SHARED, BUT IDLE

[

A A A N

STARTING
RUNING
EXITED NORMALLY

Current
Process Set

Process

View > 3

Source

View >

Performance Tuning

Debugging

Module 1
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Parallel Tools Platform (PTP)

The Parallel Tools Platform aims to provide a highly

integrated environment specifically designed for parallel
application development

Features include:

+ An integrated development environment (IDE) that

supports a wide range of parallel architectures and runtime
systems —

+ A scalable parallel debugger

+ Parallel programming tools
(MPI/OpenMP)

+ Support for the integration
of parallel tools

+ An environment that simplifies the E
end-user interaction with parallel systems

+ http://www.eclipse.org/ptp

Module 1
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Module 2: Installation

+ Objective
+ To learn how to install Eclipse and PTP

+ Contents
+ System Prerequisites
+ Software Prerequisites
+ Eclipse Installation
+ PTP Installation

Module 2
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About PTP Installation

+ PTP 3.0 isn’t “official” yet. Planned for late Oct.

+ Note: up-to-date info on installing PTP and its
pre-reqgs is available from the release notes:

http://wiki.eclipse.org/PTP/release_notes/3.0

+ This information may supersede these slides

Module 2
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System Prerequisites

+ Local system (running Eclipse)
+ Linux (just about any version)
+ MacOSX (Leopard)
+ Windows (XP on)

+ Remote system (running/debugging
application)
+ Must be supported by a resource manager
+ Open MPI 1.2+
+ MPICH 2
+ IBM PE & LoadLeveler (AIX or Linux)
+ SLURM (Linux)

Module 2
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Software Prerequisites

+ Java (1.5 or later)

+ Cygwin or MinGW (for local development on
Windows)

+ Unix make or equivalent
+ Supported compilers (gcc, gfortran, Intel, etc.)
+ Gdb for debugging (or a gdb-like interface)

+ Gcc for building the debugger and SLURM
proxies from source

+ IBM C for building the PE/LoadLeveler proxies
from source

Module 2
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Java Prerequisite

+ Eclipse requires Sun or IBM versions of Java
+0Only need Java runtime environment (JRE)
+Java 1.5 is the same as JRE 5.0

+The GNU Java Compiler (GCJ), which comes
standard on Linux, will not work!

Module 2
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Eclipse and PTP Installation

+ Eclipse is installed in two steps

+ First, the base Eclipse package is downloaded and
installed

+ Additional functionality is obtained by adding
‘features’

+ This can be done via an "update site’ that
automatically downloads and installs the features

+ Update site archives can be downloaded to install
features offline.

+ PTP requires the following Eclipse features
+ C/C++ Development Tools (CDT)
+ Remote Systems Explorer (RSE) end-user runtime

Module 2
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Eclipse Packages

+ Eclipse is available in a number of different
packages for different kinds of development

+ Two packages are more relevant for HPC:

+ Eclipse Classic

+The full software development kit (SDK), including
Java and Plug-in development tools

+ Eclipse IDE for C/C++ developers

+Base Eclipse distribution

+Base C/C++ Development Tools (CDT) (does not
include UPC)

+ Either is ideal for PTP use

Module 2
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Eclipse Installation

+ The current version of Eclipse is 3.5 (Galileo)
+ PTP 3.0 will only work with this version

+ Eclipse is downloaded as a single zip or
gzipped tar file from

+ You must download the correct version to suit
your local environment
+ Must have correct operating system version
+ Must have correct window system version

+ Unzipping or untarring this file creates a
directory containing the main executable

Module 2
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Platform Differences

+ Single button mouse (e.g. MacBook)
+ Use Control-click for right mouse / context menu

+ Context-sensitive help key differences
+ Windows: use F1 key
+ Linux: use Shift-F1 keys

+ MacOS X
+ Full keyboard, use Help key

+ MacBooks or aluminum keyboard, create a key binding
for Dynamic Help to any key you want

+ Accessing preferences

+ Windows & Linux: Window » Preferences...
+ MacOS X: Eclipse» Preferences...

Module 2
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Starting Eclipse

+ Linux
+ From a terminal window, enter

<eclipse installation>/eclipse/eclipse &

+ MacOS X
+ From finder, open the eclipse folder where you installed
+ Double-click on the Eclipse application
+ Or from a terminal window
+ Windows
+ Open the eclipse folder
+ Double-click on the eclipse executable

+ Accept default workspace when asked
+ Select workbench icon from welcome page @

Module 2
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Specifying A Workspace

+ Eclipse prompts for a workspace location at
startup time

+ The workspace contains all user-defined data
+ Projects and resources such as folders and files

Select a workspace

Th e p rom pt can be Eclipse Platform stores your projects in a folder called a

workspace.

turned off -
v Browse...

Workspace:

[] Use this as the default and do not ask again

Module 2
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L™

Eclipse Welcome Page =

+ Displayed when Eclipse is run for the first time

Java - Eclipse SDK

Module 2
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Adding Features

+ New functionality is added to Eclipse using features

+ Features are obtained and installed from an update site
(like a web site)

+ Features can also be installed from a local copy of the
update site (which can be zipped)

Module 2
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Installing Eclipse Features
from an Update Site

+ Three types of update sites

+ Remote - download and install from remote server
+ Local - install from local directory

+ Archived - a local site packaged as a zip or jar file

+ Eclipse 3.5 comes preconfigured with a link to the Galileo
Update Site

+ This is a remote site that contains a large number of official
features

+ Galileo projects are guaranteed to work with Eclipse 3.5

+ Many other sites offer Eclipse features
+ Use at own risk

Module 2
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Installing from an Update Site

+ From the Help menu, choose
Install New Software...

C/C++ - Eclipse

& Welcome

(?) Help Contents
@7 Search
Dynamic Help

Key Assist... Shift+Ctrl+L
Tips and Tricks...

4 Report Bug or Enhancement...
Cheat Sheets...

Check for Updates
Install New Software...

About Eclipse

Module 2
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o L3

Install

Galileo Update Site
L

| Available Software

+ The Galileo Site Comes Check the items that you wish to install.
already configured with Eclipse [ | /

Find more software by working with the 'Available Software Sites' preferences.

+ For example, some of the ,
contents of the Galileo site:

4+ Dynamic Languages Toolkit - iTcl Development Tools 1.0.0.v20090613-1432-3--90A55V5L9K28LC
g+ Dynamic Languages Toolkit - Ruby Development Tools = 1.0.0.v20090610-1638-7B--E_EKMO1NTYtA:
4+ Dynamic Languages Toolkit - TCL Development Tools  1.0.0.v20090610-1638-7D--EB7sQSMRjetC:

+ YO u Ca n g et C/C + + D eV ] TO O I S 4+ Dynamic Languages Toolkit - XOTcl Development Tools © 1.0.0.v20090610-1638-4--_kE77g7TAS28NCI

W % Eclipse C/C++ Development Tools 6.0.0.200906161748

fro m t h e G a I I I eo s I te / b u t oo 4+ Eclipse Java Development Tools 3.5.0.v20090527-2000-7r88FEeF)ePyvYeA3:

4+ Eclipse XML Editors and Tools 3.1.0.v200905240756-7H6FMVDxtkM-50gP
g+ JavaScript Developer Tools 1.1.1.v200906091427-77-FGBCcNBC-BeMc
q . 4+ PHP Development Tools (PDT) SDK Feature 2.1.0.v20090611-0930-51-84QACBIHRILOM
Basic tools, does not include UPC b (3100 SOA Development

4 Test and Performance

M 0 re CO m p | ete C DT I n Sta I I b Web, XML, and Java EE Development
shown later petals

Eclipse C/C++ development tools. (Binary runtime and user documentation.)
PTP 3.0 needs CDT 6.0.1,
not available yet

v

<1 Show only the latest versions of available software Hide items that are already installed

| Group items by category What is already installed?

V! Contact all update sites during install to find required software

Cancel

Module 2
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Installation: RSE

+ The RSE End-User Runtime should be installed
from the Galileo update site

= |=| 000 Mobile and Device Development
<= Eclipse C/C++ DSF gdb Debugger Integration 2.0.0.200906161748
4* Eclipse C/C++ Memory View Enhancements 1.2.0.200906161748
4+ Eclipse C/C++ Remote Launch 6.0.0.200906161748
* Eclipse Pulsar 1.0.0.v200906121354-3--85s733L3F5759DB
4+ Mobile Tools for Java 1.0.0.v200906121354-7V7ATBFEX2XZqZ-IBoXfQ
4+ Mobile Tools for Java Examples 1.0.0.v200906121354-6--BgJ99r9cEJEOYT
4* Mobile Tools for Java SDK 1.0.0.v200906121354-4--90dCFUGWM49holaAHM-gthF
4+ Remote System Explorer User Actions 1.1.100.v200905272300-31A785733L3D7H7933
* Target Management Terminal 3.0.0.v200905272300-7N-FBVC50pb0z0uZ45hjchPQEI ,

Module 2
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Installation: CDT

+ PTP 3.0 needs CDT 6.0.1

+ Update site will contain latest version
+ Update site: http://download.eclipse.org/tools/cdt/releases/galileo

+ Install any features you want [
+ Omit the testing feature: .

Work with: | CDT 6.0 - http://download.eclipse.org/tools/cdt/releases/galileo

Install

Find more software by working with the 'Available Softwar

Name Version
CDT Main Features
Eclipse C/C++ Development Tools 6.0.0.200906161748
i+ Eclipse C/C++ Development Tools SDK 6.0.0.200906161748
j» CDT Debugger Services Framework (DSF) Examples 2 200906161748
J* CDT GCC Cross Compiler Support 1.0.0.200906161748
CDT GNU Toolchain Build Support 6.0.0.200906161748
CDT GNU Toolchain Debug Support. 6.0.0.200906161748
}* CDT Utilities 5, 200906161748
Eclipse C/C++ Development Platform 6.0.0.200906161748
» f Eclipse C/C++ DSF gdb Debugger Integration 2.0.0.200906161748
* C DT 6 O 1 I S d u e a t t h e e n d Of S e t j* Eclipse C/C++ GDB Hardware Debugging 5.1.0.200906161748
L] u p J» Eclipse C/C++ Memory View Enhancements 200906161748
J» Eclipse C/C++ Remote Launch 6 200906161748
= Eclipse CDT p2 Toolchain Installer 1.0.0.200906161748

¥ 4t Fclinse CDT Testina Feature 6.0.0.200906161748
Details

CDT Optional Features 0.0.0

/' Show only the latest versions of available software Hide items that are already installed
/I Group items by category What is already installed?

' Contact all update sites during install to find required software

Cancel

Module 2




Installing PTP

In Work with type the PTP update site URL.:
http://download.eclipse.org/tools/ptp/releases/galileo/

Click Add...

Enter a name (optional) e
e.g. “PTP 3.0” e the o oty s o s

Click OK and the list of features ok i

PTP 3.0 - http://download.eclipse.org/tools/ptp/releases/galileo/

O n t h e u p d a te S i te W I I I b e Find more software by working with the 'Available Software SiteS™prefe

p O p u I a te d Name Version
S e | ect a I | th e CO m po n e n ts yo u req u i re b [CJ]u0 Fortran Development Tools (Photran)

b Parallel Tools Platform 3.0

A b Remote Development Tools
Click Next>

Details

< Show only the latest versions of available software Hide items that are already installed

< Group items by category What is already installed?

See PTP release notes for most v Contact all update sites during install to find required software
recent info on installing 3.0

Cancel

Module 2
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Installing PTP (2)

+ You will be prompted to accept the License terms
+ Accept the License terms
+ Click Finish

+ Restart Eclipse when prompted

Software Updates
It is strongly recommended you restart Eclipse for the changes to

) take effect. For some add-ons, it may be possible to apply the
changes you have made without restarting. Would you like to

restart now?

Module 2
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Restarting Eclipse

C/C++ - Eclipse
File Edit Source Refactor Navigate Search Project Run PAPI Window Help

() Welcome 83

+ Welcome page
informs you of dt
new features ) G
: o to
installed Overview
Select
workbench icon

= Parallel Tools Platform
to g O to Learn more about PTP, the Parallel Tools

workbench Platform
Yellow
Parallel Language Development Tools |nd iCates new
Learn more about PLDT, to help in developing MPI

and OpenMP programs fea t ures _] u St
installed

workbench

Workbench hasics

Learn about basic Eclipse workbench concepts

Module 2
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Installing Additional PTP Components

+ PTP has a number of additional components
depending on the installation

+ Scalable Debug Manager (SDM) - required for all
platforms to support debugging

+ PE and LoadlLeveler proxy — IBM systems only
+ SLURM proxy - systems using the SLURM resource
manager
+ Installation of these components is beyond the
scope of the tutorial

+ See the release notes for details of installing
these components

Module 2
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Module 3: Working with C/C++

+ Objective

+ Learn how to use Eclipse to develop parallel programs
+ Learn how to run and monitor a parallel program

+ Contents

+ Brief introduction to the C/C++ Development Tools
+ Create a simple application

+ Learn to launch a parallel job and view it via the PTP
Runtime Perspective
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Installation recap

+ Download and unzip/untar eclipse

+ Use Help >Install new software to get
+ CDT for C/C++ tools
+ PTP and related tools for Parallel application work
+ Build PTP binary on target machine (local or remote)

+ Launch eclipse!
Run the ‘eclipse’ executable, from icon or from

command line
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Workbench

+ The Workbench
represents the desktop
development environment

+ It contains a set of tools
for resource management

+ It provides a common
way of navigating through
the resources

+ Multiple workbenches can
be opened at the same
time
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Workbench Components

+ A Workbench contains perspectives
+ A Perspective contains views and editors

& Egc/c++
= B | 5% outline 88 (@ Make Targets| = O

BN o %Y
= stdio.h
H stdlib.h
@ main(void) : int

Binaries
» (= Debug
» [n)t Includes

perspective

#include >
#include lib.h>

int main(void) {

= puts("!!!Hello World!!!"); /
e Ito r return EXIT_SUCCESS;

——

|2 Problems 83 | Tasks| £l Console| = Properties
0 items
Description

4 Resource Location

e ————————————————————————————————————————

Writable Smart Insert gl
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Perspectives

+ Perspectives define the layout of views in the
Workbench

+ They are task oriented, i.e. they contain
specific views for doing certain tasks:

+ There is a Resource Perspective for manipulating
resources

+ C/C++ Perspective for manipulating compiled code
+ Debug Perspective for debugging applications

+ You can easily switch between perspectives
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Switching Perspectives

hrch  Project Run RULLLUE Help

+ You can switch
Perspectives by:

+ Choosing the
Window»Open
Perspective menu
Opt|0n Eclipse SDK

+ Clicking on the = [ c/ces
Open Perspective
button

+ Clicking on a 2 stdio.h
perspective shortcut U sudlib.h
button @ main(void) : int

Outline 23 (@) Make Targets, — O

BN o %~
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Available Perspectives

_ Window »
+ By d@faUIt, certain Open Perspective

perspectives are available

' = Open Perspective X))
in the Workbench . |
+ Well I use. CVS Repository Exploring
%> Debug
+ C/C++

i PTP Debug
+ PTP Runtime t8 PTP Runtime

+ PTP Debug (5 Resource

&Y Team Synchronizing

OK | cancel '\
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Resource - MyCproject/src/MyCproject.c - Eclipse SDK

Views

+ The workbench window is
divided up into Views

+ The main purpose of a view is:
+ To provide alternative ways of presenting information
+ For navigation
+ For editing and modifying information

4+ Views can have their own menus and toolbars

+ Items available in menus and toolbars are
available only in that view

+ Menu actions only
I o= i d R S o ¥
apply to the view of Outline [CENR "

+ Views can be resized ¢ main():int

Module 3
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Stacked Views

+ Stacked views appear as tabs
+ Selecting a tab brings that view to the

foreground

&

L5 Project Explorer 83

v ch.nello World

P ) Includes
v (B src
» |c| HelloWorld.c

c - Eclipse SDK

M B ECIC++
Outline 53 (®) Make Targets| — O

BN o % 7
stdio.h
stdlib.h
main(void) : int

#include <
#include

int main(void) {
("!!1Hello
return EXIT_SUCCESS;

 ————————————

|2 Problems §% = Tasks E‘ Console| [ Properties

0 items
Description

4 |Resource Location

e o e o e e e o .
Writable Smart Insert 15l




Access help
+ Help»Help Contents
+ Help»Search
+ Help»Dynamic Help

Help Contents provides
detailed help on different
Eclipse features

Search allows you to
search for help locally, or
using Google or the Eclipse
web site

Dynamic Help shows help
related to the current
context (perspective, view,
etc.)

paratie

Help

Search: |
Contents S| B

+5> Workbench User Guide

+ 5> C/C++ Development User Guide

+ 5> Running IBM LoadLeveler Batch Jok
+ > PTP Parallel Language Developmer
+ % Running IBM Parallel Environment ,
+ > Parallel Tools Platform User Guide

tools—platform

@

Using the Eclipse help system

Browse topics in the Contents frame (<)) on the left
Click on a topic to have it displayed. Use the Back
and Forward buttons to navigate within the history of
viewed topics.

Searching

To quickly locate topics on a particular subject in the
documentation, enter a query in the Search field.

Use the Search frame (") to display the Search
view. You can narrow the scope of your search by
selecting only the sections you are interested in.

Synchronizing

After you run a search and find a topic you were
looking for, click either the Refresh | Show Current

Topic button (") or Show in Table of Contents
button (k%) to match the navigation tree with the

|| currenttopic. You might also find it useful to

synchronize after following in-topic links.
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Switch to C/C++ Perspective

WILGEIUE Help

+ Only needed if New Window

you're not
3 I ready |n the CVS Repository Exploring

. Show View > | 5 Resource
perspective

Customize Perspective... Other...
Save Perspective As...
Reset Perspective

Close Perspective = Open Perspective

Close All Perspectives

Navigation CVS Repository Exploring

+What Perspective » Debug

Working Sets ¥ PTP Debug

am in in? Preferences... o7 Runtime
See Tltle Bar (5 Resource

&Y Team Synchronizing
(= C/C++ - MyHelloProject/src/MyHelloProject.c - Eclipse SDK -

File Edit Sourte=Refactor Navigate Search Project Run PAPlI Window

o | @v &v @y @v | /v BY | v Ov @ Qv | Ov | oK | cancel |
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Project Explorer View

+ Represents user’s data

+ It is a set of user defined
Fresources .1 Project Explorer &3 =0
S
+ FO|C|eI‘S b 3% Binaries
+ PrOjeCtS P mYIncludes

¥ (Hsrc
+ Collections of files and b [2 MyCproject.c
folders P (=Debug

4+ Plus meta-data
+ Resources are visible in
the Project Explorer View
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Editors

Resource - MyC| roject.c - se SDK.
i i i R Wind Help

h>
h>
ieditor |
EE
i

¢ % v =10

An editor for a resource (e.g. a file)

opens when you double-click on
a resource

The type of editor depends on the type of the resource
+ .c files are opened with the C/C++ editor
+ Some editors do not just edit raw text

When an editor opens on a resource, it stays open across
different perspectives

An active editor contains menus and toolbars specific to that
editor

When you change a resource, an asterisk on the editor’s
title bar indicates unsaved changes

.c| *MyCproject.c &3
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Source Code Editors

A source code editor is a [ElrERTTS s
special type of editor for b

¥ Returns f(x) = 3.0%x + 2.€

manipulating source

doﬁble evaluate(double x)

code A

- [/ add semicolon to end of next line

Language features are = N E::E}s ;;I= 3.0%x + 2.0
highlighted > 3

Marker bars for showing

+ Breakpoints

+ Errors/warnings
+ Tasks

Location bar for

navigating to interesting

features @  Task tag
Warning

grror




General

Ant

C/C++
Appearance
Build Console
Build Variables

Debug
Editor
Environment
File Types
Indexer
Language Mapping
Make
New CDT project \
Property Pages Se
Task Tags
Template Default®
XL C/C++ Compile
XL C/C++ Languag
Help
Install/Update
Java
Plug-in Development
PTP
Remote Systems
Remote Tools
Run/Debug
Tasks
Team

Code Style

Select a profile:
K&R [built-in]

New...

Preview:

*

* A sample source
*

#include <math.h>

class Point {
public:
Point(double A
x(xc), y(y

double distang

double Xx;
double y;
N

double Point::dist
double dx = x
double dy =y
return sqrt(d

parateltoois—pilat

Preferences

+ Eclipse Preferences allow customization of almost everything

v

Configure Project Specific Settings...

+0Open

Window » Preferences...
+C/C++ preferences allow many

Profile 'K&R [built-in]*

Profile name: |K&R [built-in]

‘Ingentation | Braces White Space Control Statements Line Wrapping

General settings
Tab policy: Tabs only

Use tabs only for leading indentations

Tab size:

Indent
'public', 'protected', 'private’ within class body
< Declarations relative to 'public', 'protected', 'private’
< Statements within function body
< Statements within blocks
Statements within 'switch' body
Statements within 'case' body
‘break' statements
Declarations within 'namespace' definition

Empty lines

Preview:

*
¥ Indentation
+
#include <math.h>

class Point {
public:
Point(double xc, double yc) :
x(xc), ylyc) {

double distance(const Point& other) const;
int compareX(const Pointé& other) const;
double x;
double y;

I8

double Point::distance(const Point& other) const
double dx = x - other.x;
double dy =y - other.y;

return sqrt(dx * dx + dy * dy);
}

int Point::compareX(const Point& other) const {

Show invisible character

options

+ Code formatting

settings
("Code Style”)
shown here
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Creating a C/C++ Application

Steps:

+ Create a new C project
+ Edit source code

+ Save and build

C/C++ jelloClsrc/l—lelloc.c - Eclipse SDK - /home/beth/ews/tutori
li-8 Edit Source Refactor Navigate Search Project Run PAPI Window Help
N ] = c++ Project
Open File...

© Project...
Close ctri+w

Close All Shift+Ctrl+W | [c-] Convert to a C/C++ Project




New C Project Wizard

Create a new MPI project

+ File»New»C Project
(see prev. slide)

+ Name the project
‘MyHelloProject’

+ Under Project types, under

Executable, select Hello
World ANSI C Project

(no makefile req’d)
and hit Next

On Basic Settings page;
fill in information for your
new project (Author

name etc.) and hit Next

C Project
C Project

Create C project of selected type

Project name: 'MyHelloProject

¥ Use default location

Location:
Choose file system:

Project type: Toolchains:
V¥ (= Executable MacOSX GCC
@ Empty Project

® Hello World ANSI C Project. €——This is a

1. Executable (XL UPC)

. Shared Library “Managed Build”

>z
%=
b (= Shared Library (XL UPC) .
b (= Static Library p ro_] eCt
b (= Static Library (XL UPC)
& Executable (XL C/C++)
& Static Library(XL C/C++)
&> Shared Library (XL C/C++)

& Executable (XL UPC) Ma keﬂ le proJeCt;
& static Library(XL UPC) i
<> Shared Library (XL Ul/ prOVI de you r

1, Makefile project own ma kefl |e

ohgiect types and toolchains only if they are supported on the platform

( cancel ) (  Finish
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Changing the C/C++ Build =9
Settings Manually

‘typefiltertext ) | Settings

Open the project properties
by right-mouse clicking on
project and select
Properties

Open C/C++ Build

Select Settings

Select C Compiler to change
compiler settings

Select C Linker to change
linker settings

It's also possible to change
compiler/linker arguments

Hit OK to close

Module 3
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Editor and Outline View

C/C++ - MyHelloProject/src/MyHelloProject.c - Eclipse SDK

+ Double-click on S| d e @6 R 90 A 8 - o Eeren

) v

SO u rce fi |e i n th e [~ Project Explorer £3 = B || [¢ MyHelloProject.c $3 = B/ 5= outline $2 (@ Make Targets| = O
: R o %Y
Project Explorer . [t o

» (= Debug \ n : @ a_function(int) : int

to open C editor o T I L e o mantoin

#include <stdio.h> a

#include <stdlib.h>

+ Outline view is T
printf("this is a function\n");
- 0 return 3;
shown for file in
- int main(void) {
"111Hello World!!1"): /* prints
editor e functions

return EXIT_SUCCESS;

|2/ Problems | ¥ Tasks | E] Console $3 . [ Properties X% pIESE ~Br5y= 08

<terminated> MyHelloProject Debug [C/C++ Application] /Users/greg/Documents/workspace/MyHelloProject/Debug/M
!'11Hello World!!!

|| /MyHelloProject/src/MyHelloProject.c
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Content Assist

+ Type an incomplete function name e.g. “get" into the editor,

and hit ctrl-space
+ Select desired completion value with cursor or mouse

a_function();
if (get)
return e getloadavg(double *,int) : int

} __ ® getpriority(int,id_t) : int
\ﬁ; @ getprogname(void) : const char *
|2 Problems {_‘1 @ getrlimit(int,rlimit *) : int
e Tminateds @ @ getrusage(int,rusage *) : int
111Hello World @ gets(char *) : char *
@ getsubopt(char * *,char * const *,char **

@ gettimeofday(timeval *,void *) : int
@ getw(FILE *) : int
# aetc_unlocked(fo)

Press '~ " to show Template Propos

a_function();
Hover over a program if (gettimeofday(Q)
__restriét,“void * __restrict);

retujng gettimeofday(struct timeval *
Press 'F2’ for focus

element in the source file to s
arc - . € F————> ——
see addltlonal Informatlon {2 Problems | v=| Tasks | £l Console $3 . [ Properties X % | =k HHE | A
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Create a Launch Configuration

Run Configurations
Create, manage, and run configurations

O\‘;“: v i:fiv Ov

Run As >

RUﬂ Conﬁgurations... 1 :: : C?’nﬁgure launch settings from this dialog:

- . type filter text - Press the 'New' button to create a configuration of the selected type.
Organlze Fa!ontes...

[c]C/C++ Application
[c]C/C++ Remote Applicat
= Launch Group ¥ - Press the 'Delete’ button to remove the selected configuration.

- Press the 'Duplicate’ button to copy the selected configuration.

+ Open the run
configuration
dialog Run»
Ru n Co nfig u ratians. . Configure launch perspective settings from the Perspectives preference page.

Select C/C++
Application

Select the New Filter matched 3 of 12 items
button

5> - Press the 'Filter' button to configure filtering options.

- Edit or view an existing configuration by selecting it.

( ‘?;

Depending on which flavor of Eclipse you

installed, you might have more choices in
Application types.
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Complete the Main Tab

+ Ensure that the correct
project is selected

+ Select the C/C++
Application (executable) if [ =
necessary T
+ Search Project... will search v [E1C/C++ Application

[€ |MyHelloProject Debug

JUSt Wlthln the prOJeCt 1C,f’C+- Remote Application

+ Browse will search anywhere B Launch Group
on the local file system Build Configuration [ Debug

Select Connect process C/C++ Application:
input/output to a
terminal if desired

Run Configurations

Create, manage, and run configurations

Name: MyHelloProject Debug

- Arguments | g Environment | %5 Debugger| &/ Source| v Refresh | ] Common

MyHelloProject (" Browse.. )

'Debug/MyHelloProject | (Search Project... ) ( Browse.. )

Z Connect process input output to a terminal.

Filter matched 4 of 13 items

.‘?;
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Complete the Arguments Tab

+ Enter any program : . Run Configurations
arguments |nt0 the teXt bOX Create, manage, and run configurations

+ Eclipse variables can also be ——
passed using the = Name: Wytisloprgec Oebus
va riables... button :Y::Zl/t:tf):pp“cmon B Mai g Environment| %5 Debugger| &, Source| 1" Refresh | ] Common

Program arg

[t |MyHelloProject Debug

SeIeCt a different Working [C]C/C++ Remote Applicatic
directory if desired > Launch Group

( variables... )
Working directory:

? Use default

-— / \ / Revert
Filter matched 4 of 13 items
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Complete the Debugger Tab

Run Configurations
Create, manage, and run configurations

Select Debugger tab
Make sure gdb/mi |S | : o Name: |MyHelloProject Debug

Selected - (] Main | 69= Arguments | Fg Environmen 7% Source | v Refresh | (-] Common
¥ ¢ |C/C++ Application
[ |MyHelloProject Debug Deb - | gdb/mi
Cha nge Where the [C]C/C++ Remote Application couaser
. = Launch Group
program should stop if

d eSi red ["Main  Shared Libraries |

Change any gd b-speCifiC GDB debugger: ‘gdb 1 (" Browse... )
Options If deSi red GDB command file: .gdbinit / Browse... \
(a d Va N Ced u Se rS O n IY) (Warning: Some commands in this file may interfere with the startup operation of the debugger, for

example “run®.)

4> ‘z Stop on startup at:  main ( Advanced... )

Debugger Options

GDB command set: | Standard (Mac OS)

Protocol: [ mi

The information on the  Verbose consale mode
debugger tab Wi” Only be [ Use full file path to set breakpoints
used for a debug launch

+ Hit the Run button to
launch your program

Filter matched 4 of 13 items
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L A\

Viewing Program Output =4

+ When the program runs, the Console view should automatically
become active

+ Any output will be displayed in this view (stderr in red)

|2 Problems | | Tasks | & Console §2 . [ Properties R &S By = 0O

<terminated> MyHelloProject Debug [C/C++ Application] /Users/greg/Documents/workspace/MyHelloProject/Debug/NM
111Hello World!!!
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Module 4: Working with MPI

+ Objective

+ Learn how to build and launch an MPI program
+ Explore some of the features to aid MPI
programming
+ Contents

+ Using a version control system (CVS)
+ Building with Makefiles and autoconf
+ MPI assistance features

+ Working with resource managers

+ Launching a parallel application

Module 4
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Creating the Project

+ Configuring version control
+ Checking out the source code
+ Team support

Module 4
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Connecting to a Repository

+ Select Window »Open
Perspective »Other...

+ Select CVS Repository
Exploring then OK

Module 4
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Specify Repository Location

Add CVS Repository

Add a new CVS Repository

nght_CIICk In the CVS Add a new CVS Repository to the CVS Repositories view
Repositories view, then select A
NeW’RePOSitory Location"' Host: cvs.ncsa.uiuc.edu

Set H ost to th e h Ostn a m e Of Repository path: | /CVS/cluster2009
re m Ote m a Ch | n e Authentication

User: tutorial

Set Repository path to the CVS e
repository path Connection

Connection type: | extssh

Fill in Username and Password ® Use default port

Set Connection type to extssh (O Use port:
tO U Se a n SS h CO n n eCtI O n ["] Save password (could trigger secure storage login)

Ch eck Save passwo rd If yo u To menage your p;lxssword. ?Iease see 'Secure Storage'
. Configure connection preferences...
wish to save the password

Select Finish

Z Validate connection on finish

Module 4
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CVS Repository Exploring

CVS Repository Exploring - cvs.ncsa.uiuc.edu/CVS/cluster2009/tutorial /samples/mpqc-2.3.1/src/bin/mpgc/mpqgc.cc 1.1.1.1

Open the repOSItOry |n i Q- | Py | @8 v &l v ¥ G Sy B (@2 CVS Reposit... [ C/C++

the CVS RepOSitOI'y S | B ¥ = 8|/ mpac.cc 1.1.1.1 8§ =7

v | | :extssh:grw@cvs.ncsa.uiuc.edu: /CVS/cluster2009 // w

VieW v |} HEaD // mpqc.cc

» (= CVSROOT o e 100 ,
P (= lockdir / Copyright (C) 1996 Limit

Open HEAD to view v wiori 77 Author: Edward Seidl <seidle

¥ (= samples / Maintainer: LPS

files and folders in the v mpac-231

P = bin

CVS head e 7 1t 1 fre sofmars o co sttt 5 o ity

» (= lib s publishe
=

Open Branches or Ve

¥ (= bin

Versions to view CVS + G2 molrender

¥ (= mpqc // but WITH 1
H P (= sample / MERCHANT or N ( A PARTICULAR P
bra nCheS Or VerS|OnS » (= validate // GNU General Public License for more details.

ccarun.in 1.1.1.1

respectively ccarunproc 1111 received  copy of the GNU General Public Li

Right-click on the Efprye s, commt, o ot o e i o a3
repoSitory and select e
Refresh Branches... Quews

to see all branches and &

versions

your option)

= History 23

tutorial/samples/mpqc-2.3.1/src/bin/mpqc/Makef...;extssh:grw@cvs.ncsa.uiuc.edu: /CVS/cluster2009

Module 4
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Check out as an Eclipse Project

New

In CVS Repositories view, right-click

. i Check Out
on project and select Project» Check Check Out As...
out As... i Tag as Version...

Make sure Check out as a project e D
configured using the New Project e
Wizard is selected Compare
Leave Checkout subfolders 1 Add to Branch List...
Checked Che;k c,)u[ - Check Out As

- - Select the method of check out
Select Finish

Choose how to check out folder 'mpgc-2.3.1"
@ Check out as a project configured using the New Project Wizard

f:_“ Check out as a project in the workspace
Project Name:

f:" Check out into an existing project

M Checkout subfolders

Working sets
7] Add project to working sets

Working sets:

) ( cancel ) (& Finish-)

Module 4
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Create a C Project

The New PrOject Wizard |S used Create a new C project
to create a C project

i type filter text

(2% Java Project
£ Java Project from Existing Ant Buildfile
7 Plug-in Project
» (= General
v(=C/C++

[E¥C++ Project

Enter Project name C project

Under Project Types, select
Makefile project» Empty
P ro j e Ct i:::efaun location
+ Ensures that CDT will use existing Choose file system:
makefiles Nt vpe:

NWShared Library (XL C/C++) -- Other Toolchain -~
— — < Exgcutable (XL UPC) MacOSX GCC
Select FI n ISh <> StatfyLibrary(XL UPC) XL C/C++ Tool Chain
() Shared rary (XL UPC) O XL UPC Tool Chain

When prompted to switch to the T —
C/C++ Perspective, Select Yes |21 Show project types and toolchains only if they are supported on the platform

) ( cancel ) € Finish )

Module 4
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Building the Application

+ Configuring the project build directory
+ Generating Makefiles

+ Creating a Make Target

+ Running the build

Module 4
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Create a build directory

This program requires a separate build directory
Select the project in the Project Explorer view

From the File menu, select elect New » Folder...
Make sure the parent folder is correct

Enter “build” as the folder name

Click Finish

® Eclipse Edit Source Refactor Navigate Search Project Run Window Help

) C++ Project
¢ C Project
Close BW % Project...
Close All ¢ 8EW

Open File...

Y : _ ) ) (O=
s Brolect Explorey ] Convert to a C/C++ Project |

7 Source Folder

vizi>mpac (s,  [5] Save As... & Folder

jaclocal.m4 ¢’ Source File
| CHANGES

| CITATION n Header File
[ config.log “ File from Template

| configure @& Class

J configure.

| COPYING c Line Delimiters T 77 Other... #EN
R corvingle Convert Line Delimiters 10 "Eerms of the GNU General Public [i¥
J LICENSE 1 tware Foundation; either ver
3 Makefile | rsion.

c3 AN >
sion Z,

Module 4
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Makefile Project

+ Similar to managed project, but uses custom
Makefile (or other script) to control build

+ User can specify command that will be used to
initiate build

+ Can also specify the directory in which the
build will take place

+ "Make targets” are used to control type of
build

+ Can switch between managed and un-
managed project

Module 4
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Makefile Project Properties

Right click on project in
Project Explorer to
bring up properties
Click on C/C++ Build
for the build settings

Can change build
command if desired

Change the Build
location to the build
directory in the project

Module 4

® 00

Properties for mpqc

' type filter text

Resource
Builders
v C/C++ Build
Build Variables
Discovery Options
Environment
Settings
Tool Chain Editor
XL C/C++ Compiler
»C/C++ General
CVs
Project References
Run/Debug Settings
b Task Repository
WikiText

C/C++ Build

( > ' - - hY
Configuration: | Default [ Active ] ﬂ _Manage Configurations...

Builder Settings ~ Behaviour

Builder
Builder type:

@ Use default build command

Build command:

Makefile generation

v Ex

Build location

= Build directory: | ${workspace_loc:/mpqc/build}

/ Workspace... \ / File system... \ (" Variables... \

( Restore Defaults ) (  Apply )

( OK f Cancel \
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About Makefiles and autoconf

+ Autoconf is a GNU utility often used to create Makefiles
for open source projects

+ Used to generate a configure script

+ Configure is run to generate a Makefile that suits a
particular system configuration

+ Normally only needs to be run once, unless the build
process needs to be changed

+ Run configure using two methods:
+ Manually from an external shell
+ By creating an External Tools Launch Configuration

+ Must refresh Project Explorer whenever file system is
modified outside of Eclipse, such as after running
configure

Module 4
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Generate the Makefiles

(< NONS) External Tools Configurations

From the Run menu, select —
Create, manage, and run configurations

External Tools»External [

Tools Configurations...

Create a new Program Lo RIE T Name: [confgure

' type filter text

For Location, click Browse |[BOtr .
g gearon
Workspace"' and flnd the S— ${workspace_loc:/mpqc/configure}

Configure Script (“Browse Workspace... ) ( Browse File System... ) ( Variables... )
For Working Directory, Working Directory

click Browse Workspace... Stworkspace_loc:/mpac/build)

and select the build (" Browse Workspace... ) ( Browse File System... ) ( Variables... )
directory in the project e

Click Run and you should

see output in the Console

view

In Project Explorer, right-

click and select Refresh to

see the new files that have Filter matched 2 of 3 items
been created

=‘|_| Main 5 Refresh | g Build | B Environment | =] Common

( Variables... \

Note: Enclose an argument containing spaces using double-quotes (").

Module 4
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Create a Make Target

Select the project in
Make Targets view

Click on New Make
Target icon

Enter the desired name
of the target

Unselect Same as the
target name and delete
“build”

+ This will run the "make”
command with no
arguments

Select OK

Module 4

SDK

Y [23CVS Reposit... HgjC/C++

= 8 || 5= Outline | (&) Make Targets &3

_ #mpgc

=% MyHelloProject
=% myMakefileProject

e 0 Create Make Target

Target name: build
Make Target
[") Same as the target name

Make target: ||

Build Command
IZ[ Use builder settings

Build command:

Build Settings
M Stop on first build error

Iﬂ Run all project builders

Cancel \ ( OK )
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Running the Build

VS/cluster2009/tutorial/samples/mpqc-2.3.1/src/bin/mpgc/mpqgc.cc 1.1.1.1 - Eclipse SDK ()

+ Open the pl"O_]eCt |n the R B [ B-O- Qv | @ 55 [B3CVS Reposit... TgC/C++
Make Ta rg ets VieW tO | | mpgc.cc 1.1.1.1 52 0= Outline | (@) Make Targets 53
see the build target 177 apac.cc @&

+ Double-click on the build L bt
target to initiate the build | & incude

» (= lib
is part of MPQC. =

+ Output from the build will | — St

you can rean

b =5 MyHelloProject

be ViSible In the ConSOIe (“O ’u”gg‘(ﬁi‘” v(j ersion L:CmyMakeﬁleProject
view '

/ MPQC is distributed in the

/ but WITHOUT ANY WARRANTY; wi even the impli
/ MERCHANTABILITY or FITNESS F( A PARTICULAR PURF
// GNU General Public Li for more details

should have receive D the GNU Genet
q with the Q ee the > COPYING If o
S , 675 Mass Ave, Camt

A

oftware Foundation

.S N is granted a limited licens¢Y

~ \ e ] <>

|2 Problems | v Tasks | £l Console 83 | Properties ¢ Progress D G|t B =8

C-Build [mpgc]

g++ -M -c -DHAVE_CONFIG_H -D_REENTRANT -I../../../../../src/1ib -1/Users/greg/Documents/
workspace/mpqc/include -I1/Users/greg/Documents/workspace/mpqc/src/1ib -0 /Users/greg/ O
Documents/workspace/mpqc/src/lib/chemistry/qc/oint3/13301AB.cc | sed 's/Ai3301AB.o/
13301AB.o0 13301AB.d/g' > 13301AB.d

g++ -M -c -DHAVE_CONFIG_H -D_REENTRANT -I../../../../../src/1lib -1/Users/greg/Documents/
workspace/mpgqc/include -1/Users/greg/Documents/workspace/mpqc/src/lib -0 /Users/greg/
Documents/workspace/mpqc/src/lib/chemistry/qc/oint3/13300AB.cc | sed 's/Ai3300AB.o/
13300AB.0 13300AB.d/g' > 13300AB.d

- RUAVE FAMETE 1L N BEEATRAMT T ’ Fmm e £Y 20 R P e L P S

&
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MPI Assistance Tools

Added by PLDT (Parallel Lang. Dev. Tools)
feature of PTP

+ MPI Context sensitive help
+ MPI artifact locations

+ MPI barrier analysis

+ MPI templates

Module 4
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Context Sensitive Help

Click mouse, then press help
key when the cursor is within a
function name

+ Windows: F1 key

+ Linux: ctrl-F1 key

+ MacOS X: Help key or

Help»Dynamic Help

A help view appears (Related
Topics) which shows
additional information
(You may need to click on MPI
API in editor again, to
populate)

Click on the function name to
see more information

Move the help view within your
Eclipse workbench, if you like,
by dragging its title tab

Module 4

Related Topics

+ About
Click below to see help.

See also:

AP REPE
\w,,\‘u,‘:{. BLe e

(= Editor view
B int MPI_Comm_ranMPI_Comm, int *)

@D Help 2
& @l -

MPI Comm rank
int MPI_Comm_ rark (MFPI_Comm, int *)

Retums the rank of the local
task in the group associated
with a communicator.

Some
special info
has been
added for
MPI APIs.




Select source file; Run
analysis by clicking on
drop-down menu next
to the analysis button
and selecting Show e
MPI Artifacts
Markers indicate the

location of artifacts in
editor

In MPI Artifact View

¥ 2 MyMPlproject
b 3% Binaries
P wYIncludes

v Bsrc

sort by any column
(click on col. heading)

Navigate to source code
line by double-clicking
on the artifact

Run the analysis on
another file and its

markers will be added to
the view

Remove markers via [l I

Module 4

o | Eiv B3y [y Gv

v @ Qe D

=}
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Show MPI Artifacts

source;
dest = 0;
tag = 0; g S
message[100]; storage f sage
status ;

int

int

char
MPI_Status

start up MPI

MPI_Init(&argc, &argv);

find out process

’ Show MPI Artifacts
’ Show OpenMP Artifacts
/7 MPI Barrier Analysis

ef3a# Navigate Search Project Run Window Help

Qv B f}v OV q‘v

O & 5 5 [EeiC/CH+
8= Outli 53
% RN e

= mpi.h
 stdio.h
= string.h

return status for receive

@ calc_pi(int, int)

@ main(int, char'[

rank

MPI_Comm_size(MPI_COMM_WORLD, &num_procs);

[

ix‘:::;vmﬁ

I Filename I LineNo | Construct

» MPI_Bcast

» MPI_Reduce
» MPI_Init

»

P MPI_Comm_size
» MPI_Send

» MPI_Recv

» MPI_Bcast

¥ MPI_Finalize

Wiritable

MyMPlproject.c 22
MyMPlproject.c 37
MyMPlproject.c 57

Function Call
Function Call

Function Call

MyMPlproject.c 63
MyMPlproject.c 70
MyMPlproject.c 75
MyMPlproject.c 84
MyMPlproject.c 94

Function Call
Function Call
Function Call
Function Call

Function Call

Smart Insert | 60: 18
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MPI Barrier Analysis

= C/C++ - MyBarrier/src/MyBarrier.c - Eclipse SDK - C:\ews\runtime-cdt40

File Edit Refactor Source Statistics Navigate Search Project Run Window Help

|6 @ e e $-0- @5 o mlEor Verify barrier

L5 Resource

’ - - L
L Project Explorer 22 = B [¢] matrixio.c l.€] zzzzTemplateTest.c Déj MyBarrier.c &2 = O[5 outline 52 (@) Make Targets| — O syn Ch ro n Izatl o n I n CIM PI

if (my_ rank !=0) L laz \ \s e v

=) > MyBarrier - o stdio.h prog rams
sprintf (message, "Greetings from process %d! o

%[l Indludes dest = 0: :-l sb’lﬁg.h
= src . ) . o mpih

<> * use strlen+l so that 0 get transmittec
+-git] MyBarrier.c @ Barrier() : void
L MPI Send (message, strlen(message)+l, MPI CHZ =B
#-(= Debug = -

5 65 marome . T e Interprocedural static

—C MPI Barrier (MPI COMM WORLD);
+-f3= MySampleProject PSSR - -

}

analysis outputs:

printf ("From process 0: Num processes: %d\n'
for (source = 1; source < p; source++) {
MPI_Recv(message, 100, MPI_CHAR, source,
MPI_COMM WORLD, &status):;

printe (+i3\nt,message) +For verified programs,

MPI Barrier (MPI_ COMM WORLD) ;

A e | lists barrier statements that
— <] > o
Function |2 Problems | | Tasks | E] Console | "% Barrier Matches 5% = O || ¥4 Barrier Errors 2 i ¥ =08 SynCh ron Ize together
i ¥ Barrier Matching Set Function ( m atC h )

=
Barrier Matching Set Function Filename LineNo  |; /) Error men
+- W Path 1 (1 barrier(s))

o h 32":;;:?1 2:::: :zg:::jz 2 Wi path 2 (0 barrier(s)) + F or Sy n Ch ron |Zat|0 N
Barrier /) Barrier 3 MyBarrier.c a1 =W Error

=W Barrier 2 (1) main MyBarrier.c 31 & W Loop (dynamic number of barriers) e rro rS y re p O rtS CO u n te r

"4 Barrier 2 main MyBarrier.c 31
=)W Barrier 3 (2) main MyBarrier.c 41

. example that illustrates and

" Barrier 3 main MyBarrier.c 41

Whtar 4 e wearre 5 explains the error

+- W Barrier 5 (1) main MyBarrier.c 62
) (Il

}

Module 4
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MPI Barrier Analysis - V|ews

/7 MP1 Barriers 23 = B |/[2. Problems | | Tasks | &l Console | % Barrier Matches &2 = O || Barrier Errors &2 =0

i || Barrier Matching Set Function
=" Error main
+-W Path 1 (1 barrier(s))
i Path 2 (0 barrier(s))
=W Error main
+-" Loop (dynamic number of barriers)

Function Barrier Matching Set | Function Filename LineNo [
=W Barrier 1 (2) Barrier MyBarrier.c
/i Barrier 1 Barrier MyBarrier.c 8
4 Barrier 3 main MyBarrier.c 41
=W Barrier 2 (1) main MyBarrier.c 31
/i Barrier 2 main MyBarrier.c 31
= Barrier 3 (2) main MyBarrier.c 41
/i Barrier 1 Barrier MyBarrier.c 8
/i Barrier 3 main MyBarrier.c 41
i Barrier 4 (0) main MyBarrier.c 57
+- U Barrier 5 (1) main MyBarrier.c 62

MPI Barriers view Barrier Matches view Barrier Errors view
Groups barriers that

match together in a If there are errors, a
Like MPI Artifacts view, parrier set — all counter-example

double-click to navigate processes must go shows paths with
to source code line (all  through a barrier in the ~ MiSMatched number
3 views) set to prevent a of barriers

deadlock

Simply lists the barriers

Module 4




paratel—toois—platiform

MPI Templates

+Allows quick entry of
common patterns in MPI MPI_Comm_rank(VPI_COMM_WORLD, &rank);
programming CF Crank o= 031 //naster task

task

+Examp|e. MPI Send_ brintf("liello From process @: Num processes: %d\n",p);

for (source = 1; source < p; source++) {

recelve MPI_Recv(pessage], 100, MPI_CHAR, source, tag,

MPI_COMM_WORLD, &status);

+Enter: mpisr <ctrl- printf("%s\n",message);
space> S

sprintf(message, "Hello from process %d!", my_rank);
dest = 9;
/* use strlen+l so that '"\@' get transmitted */
MPI_Send(message, strlen(message)+1l, MPI_CHAR,

dest, tag, MPI_COMM_WORLD);

+Eclipse preferences: add more!
+C/C++ > Editor > Templates
+Extend to other common patterns

Module 4
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Running the Program

+ Terminology

+ PTP Runtime Perspective
+ Resource Managers

+ Launch Configurations

Module 4
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Terminology

+ The PTP Runtime perspective is provided for
monitoring and controlling applications

+ Some terminology

+ Resource manager - Corresponds to an instance of
a resource management system (e.g. a job
scheduler). You can have multiple resource mangers
connected to different machines.

+ Queue - A queue of pending jobs

+ Job - A single run of a parallel application

+ Machine - A parallel computer system

+ Node - Some form of computational resource

+ Process - An execution unit (may be multiple
threads of execution)

Module 4
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Resource Managers

+ PTP uses the term “resource manager” to refer to any
subsystem that controls the resources required for
launching a parallel job.

+ Examples:

+ Job scheduler (e.g. LoadLeveler)
+ Open MPI Runtime Environment (ORTE)

+ Each resource manager controls one target system
+ Resource Managers can be local or remote

Module 4




+ Open using legend icon in

toolbar

Module 4
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About PTP Icons

——

-

Resource Manager Icons

@ STARTING
@ STARTED
@ STOPPING
., STOPPED
. SUSPENDED
ERROR

Machine Icons
UP
DOWN
ALERT
# ERROR
?. UNKNOWN

Job Icons
PENDING
STARTED
RUNNING
TERMINATED
SUSPENDED
ERROR
UNKNOWN

Node Icons

=
=
X |
2

hd

up

DOWN

ERROR
UNKNOWN
USER EXCLUSIVE

Process Icons

>

v
-
¥

STARTING

RUNNING

EXITED NORMALLY
EXITED WITH SIGNAL
SUSPENDED

ERROR

UNKNOWN

USER SHARED

OTHER EXCLUSIVE
OTHER SHARED
PROCESS RUNNING
PROCESS TERMINATED

\\
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- ‘—:‘\\

Open PTP Runtime Perspective

Window > Open Perspective > Other...
uew Window

en Perspective | %5 Debug

Show View > &Y Team Synchronizing o
CVS Repository Exploring

Customize Perspective... Other... %> Debug
Save Perspective As... \ % PTP Debug

Reset Perspective 855 PTP Runtime\
Close Perspective .’y Resource

Close All Perspectives &Y Team Synchronizing
Navigation

Working Sets
Preferences...

Module 4
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PTP Runtime Perspective

Resource
managers view

Machines view

Node details
view

Jobs view

Module 4

& PTP Runtime - mpitest/mpitest.c - Eclipse SDK
File Edit Refactor Navigate Search Project Run Window Help

i) W | By Oy Qv ]

(¥) Resource Managers &3 =g

&3 Machines 2 =08
Please select a machine

Node Attributes Process Info
Attribute Value

g8 Jobs 3 =0
Please select a job
[

{ |88 PTP Runti... [EC/C++

[ mpitest.c &

#include <mpi.h>
#include <stdio.h>

int
main(int argc, char *argv[])
{

int rank;

MPI_Init(&argc, &argv);
MPI_Comm_rank (MPI_COMM_WORLD, &rank);
printf("hi from %d\n", rank);
MPI_Finalize();

exit(0);

El Console 2 - [Z. Problems [ Properties v Tasks €] Error Log

No consoles to display at this time.




Adding a Resource Manager

& PTP Runtime - mpitest/mpitest.c - Eclipse SDK
File Edit Refactor Navigate Search Project Run Window Help

+ Right-click in Resource = | % O Q-
Managers view and select — [ER N
Add Resource Manager

+ Choose the Open MPI
Resource Manager

Type

Choose Resource Manager Type

Select the type of resource manager to use

Resource Manager Types:
IBM LoadLeveler

IBM Parallel Environment
MPICH2

+ Select Next>

Next > Cancel

Module 4
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m_—
L =\

——

Configure the Remote Location

+ ChooselR S N CIN eI
Open MPI connection configuration Se rV|Ce prOVIdeI‘

Enter Open MPI connection information Choose Remote Iocation or
| . click New... to create a new
Remote service provider: (RSE |5 |OcatIO N

Remote location: (ol W + Local can be used to run
Multiplexing Options applications IOcally

® None Some resource managers

Local address:  localhost _ Support tunnellng over SSh
~ connections (e.g. Remote
Tools)

The port forwarding option
would be enabled this if it was
available

—— N\ o
( <Back Next > Cancel ) ( Finish )

Module 4
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J \
- >

—_——

Create a New Location (RSE)

(G HONG) New Connection

1 Select Remote System Type Choose SSH on Iy fO r th IS
Connection for SSH access to remote systems CO n n ECtIO n

Click Next>

| ( type fiter text ' Enter Host name of remote
v (= General System

T FTP Only

A Linux Click Finish

=l Local

unix Unix ‘ (&) (@) New Connection

# Windows } Remote SSH Only System Connection

Define connection information

Parent profile: | Jarrah

Host name: abe.ncsa.uiuc.edu
( Next > \ / Cancel \

Connection name: abe.ncsa.uiuc.edu

Description:

W Verify host name

) / Cancel ( Finish \

Module 4




800 + The Open MPI resource
Open MPI tool configuration manager will auto detect
Enter information to configure the Open MPI tool the version and use the
appropriate commands

+ Change only if you're an
Tool Commands eXpert

Click Next>

Open MPI version: | Auto Detect

Launch command:

Change the Name or
Debug command: Description of the

Discover command: at resource manager if you
Installation Location WlSh

¥ Use default location 4+ Click Finish
Location: 900

| Choose Resource Manager Name and Description

| _—
Enter a name and description for the resource manager

@ Use default name and description:

| Name:

.. Description:

MOdU/e 4 ‘: N : ) ( Finish




+ Right click on new
resource manager and i | 35 O Qv Qv
select Start resource (2) Resource Managers 53
manager ' B Add Rehs;u_re M‘a-nAa;ger...
If everything is ok, you Remove Resource Manager
should see the resource Edit Resource Manager

manager change to green

ooo .
oo Machines 3

If Somethlng goes wrong, Please select a machine - Start Resource Manager
it will change to -

MRE AL A A
() Resource Managers 53

?>.Open_MPi@abe.ncsa.uiuc.edu (Open MPI | #> Open_MPI@abe.ncsa.uiuc.edu (Open MPI (

Module 4
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System Monitoring

Machine status shown in
Machines view

Node status also shown
Machines view

Hover over node to see
node name

Double-click on node to
show attributes

Module 4

e 00 PTP Runtime - mpqc/

b -, a9 > 'S
v o0 | RFY IV ‘1" vig~ Dv

(© Resource Managers 23
» (2) Open_MPl@abe.ncsa.uiuc.edu (Open MPI)

82 Machines &3 AN . =0
Open_MPl@abe.ncsa.uiuc.edu: Open_MPl@abe.ncsa.uiuc.edu - Root [8]

“=- Open_MPl@abe.ncsa.uiuc.edu O!l_ll_lLIl_lLll_lLl

Node Attributes Process Info
Attribute Value

Name honest2.ncsa.uiu

Node Number 0

Node State upP

Open MPI number 1




paratel—toois—platiform

- ‘—:‘\\

Create a Launch Configuration

Run Configurations

Create, manage, and run configurations

@K‘;“: v !jﬁ v O v

Create a configuration to launch a parallel application in Parallel Perspective

Run As >

———————————— 3 Configure launch settings from this dialog:
Run Configurations... .

. . Press the 'New' button to create a configuration of the selected type.
Organize Fayvorites..) _ : .
€] C/C++ Application = - Press the 'Duplicate’' button to copy the selected configuration.

= Launch Group ¥ - Press the 'Delete’ button to remove the selected configuration.

+ Open the run
configuration
dialog Run»
Run Config urations... Configure launch perspective settings from the Perspectives preference
Select Parallel Pegs:

H H >
Appllcatlon Filter matched 3 of 3 items
Select the New
button

: Parallel Application 2 - Press the 'Filter' button to configure filtering options.

- Edit or view an existing configuration by selecting it.

Depending on which flavor of Eclipse you

installed, you might have more choices in
Application types.

Module 4
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Complete the Resources Tab

+ In Resources tab,
select the resource
manager you want to
use to launch this job
Enter a value
in the Number of
processes field

Other fields can be
used to specify

resource manager-
specific information

Module 4

(SIeNe)

Run Configurations

Create, manage, and run configurations

W

@ [Application]: Application program is not specified

X | B o

Name: mpqc

type filter text

&% Resources Y] Application| Synchronize %% Debugger| ®= Arguments| % Source| P8 Environment| 1

v [T]C/C++ Application
[€]MyHelloProject Debug
[€]C/C++ Remote Application
# Launch Group
v 8=} Parallel Application

Resource Manager: | Open_MPl@abe.ncsa.uiuc.edu m

Launch Attributes

Basic Open MPI = Advanced Open MP| !

Number of processe
Options

D¢

1By node By slot | No oversubscribe ! No local
[ Prefix:

Hosts

[ Host file:

[ Host list:

Filter matched 6 of 15 items

@




Complete the Application Tab

® 0 Run Configurations

+ S e I eCt t h e Create, manage, and run configurations /,,,,,\
Application tab @ [Debugger]: SDM path is invalid &QJ

+ Choose the LRI Name: mpac
Application program [RSEEsE..
(executable) by ~ [2]MyHelloProject Debug e

[€]C/C++ Remote Application mpac Browse

Cl iCki ng the Browse = Launch Group

v 5=} Parallel Application Application program:

button £ mpac Jujac/grw/mpqgc/bin/mpcq ( Browse

+ LOca| prog ram: ") Copy executable from local filesystem
exeCUtab|e IS under Path to the local file:
Debug folder in the

p rOJ ect ") Display combined output in a console view

Remote program:
must copy to remote
machine; navigate to
its location on the
remote machine here

Select Display
combined output in
a console view if
desired

&= Resources| =] Application . Synchronize ke Debugger| ®= Arguments| & Source | 7§ Environment “l

Filter matched 6 of 15 items

Module 4
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Complete the Debugger Tab

® "o Run Configurations

Create, manage, and run configurations

Select Debugger tab
Choose SDM from ——

type filter t C ) = .
the Debugger b Lo ) & Resources | E] Application |Synchronize(%* Debugger ) ®= Arguments | % Source | P& Environment| 1

v [c |C/CTFTARppH
d ro pd own [ MyHeIIo;roject Debug Debu?r: (SDM

[€]C/C++ Remote Application

U se th e B rowse . é""{ ;:l:anllcehl i::;:iia(ion ¥ Stop at main() on startup
button tO SeleCt the imeac Pathi; debpugger executable:
debugger executable R

+ If launching remotely, }Debuggersessnon address:
the debugger
executable must also
be located remotely

Set debugger session
address (covered
later)

C“Ck On Run tO Filter matched 6 of 15 items
launch the program

Create a configuration to launch a parallel application in Parallel Perspective

X B2

localhost

@

The debugger settings will not be used until the
application is launched under the debugger

This will be covered in more detail in Module 6
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eo00 PTP Runtime - job0:0 - Eclipse SDK

+ DOUb'E-ClICk ad [~ w |35 Q- Q- Q- OB 5 VU =Y [ 888PTP Runtime BEC/C++

ooo

(3 Resource Managers 23 @ Makefile g8 job0:0 &2

n Od e I n m a Ch i n eS » (2) Open_MPl@abe.ncsa.uiuc.edu (Open MPI) s
view to see which

Status: EXITED

processes ran on  [Freee ————  rogram out

= STATUTTY 1T STUC UL 7 Uy aC/ grwy TPy Cy oy impyc Uy acj grwy
th e n Od e Open_MPl@abe.ncsa.uiuc.edu: Open_MPT®magacsa.uiuc.edu - Root [8) mpqc-2.3.1/src/bin/mpqc/sample/newton.in
““Open_MPl@abe.ncsa.uiuc.edu

MPQC: Massively Parallel Quantum Chemistry
Version 2.3.1

Machine: x86_64-unknown-linux-gnu
User: grw@honestl.ncsa.uiuc.edu

Hover Over a Start Time: Thu Aug 27 21:21:47 2009

Using ProcMessageGrp for message passing (number of nodes =

process for tooltip gy %

Using PthreadThreadGrp for threading (number of threads = 1).
Attribute Value ¥ job0:0

popu p Name honestl.ncsa.uiu ¥ job0:1 El Cons 8 _[2 Prob | & Prop | ¥ Task | €] Error| 5 Rem | &3 Rem

Node Number % Open_MPI@abe.ncsa.uiuc.edu:default:;job0 x bl BT
Node State up rOrminyg UpPTUMLZUTION COUruLrnutes
Open MPI number 1 SymmMolecularCoor: :form_variable_coordinates()

expected 3 coordinates

SymmMolecularCoor: :form_variable_coordinates()

Job and processes prpeciad 3 coordinates
o0 ggg N & - - found 2 variable coordinates
i i 888 Jobs &3 . 552 Jobs List { - found @ constant coordinates
S h OW n I n J O bs Open_MPI@abe.ncsa.uiuc.edu: default:job0 - Root [4] found 2 variable coordinates
PP R Y] found @ constant coordinates
. N vevy Reading file /u/ac/grw/mpqc/share/mpqc/2.3.1/basis/3-21g.kv.
V I eW Reading file /u/ac/grw/mpqc/share/mpqc/2.3.1/basis/3-21g.kv.
Reading file /u/ac/grw/mpqc/share/mpqc/2.3.1/basis/sto-3g.kv.
Reading file /u/ac/grw/mpqc/share/mpqc/2.3.1/basis/sto-3g.kv. 4

v

< »
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eo00 PTP Runtime - job0:0 - Eclipse SDK

il w | QR @y O 2B s v {3l =1 [ 888PTP Runtime [EC/C++

ooo

(3 Resource Managers 23 @ Makefile g8 job0:0 &2

» (2) Open_MPl@abe.ncsa.uiuc.edu (Open MPI) e

‘.’ DOUbIe'C“Ck d :I(iuz.ssto
process to See 828 Machines 23 &, o &y =8 e e GO

) SLATUITTY I STOC UL JUuydcy grw impyey o mpye juyacjyrwy

p ro CeSS d eta i | a n d Open_MPl@abe.ncsa.uiuc.edu: Open_MPl@abe.ncsa.uiuc.edu - Root [8) mpqc-2.3.1/src/bin/mpqc/sample/newton.in

==-Open_MPl@abe.ncsa.uiuc.edu o [ I I I T I I MPQC: Massively Parallel Quantum Chemistry

standard output
from the process User: " gr@honestl ncsauiuc ods

Start Time: Thu Aug 27 21:21:47 2009

Using ProcMessageGrp for message passing (number of nodes =
1).
Process Info Using PthreadThreadGrp for threading (number of threads = 1).
Value +’job0:0
honestl.ncsa.uiu ¥ job0:1 El Cons 8 _[2 Prob | & Prop | ¥ Task | €] Error| 5 Rem | &3 Rem
Open_MPI@abe.ncsa.uiuc.edu:default:job0 w2 BT
rorminy opuumiZuation coorulnutes s
SymmMolecularCoor: :form_variable_coordinates()
expected 3 coordinates
SymmMolecularCoor:: form_variable_coordinates()
expected 3 coordinates
o ooo aoo N o - found 2 variable coordinates
CO n SO I e d Is p I a ys 82 Jobs X &28 Jobs Lis i - found @ constant coordinates
- found 2 variable coordinates
CO m b I n ed O u tp ut found @ constant coordinates
Reading file /u/ac/grw/mpqc/share/mpqc/2.3.1/basis/3-21g.kv.
Reading file /u/ac/grw/mpqc/share/mpqc/2.3.1/basis/3-21g.kv. O
from a I I p rocesses Reading file /u/ac/grw/mpqc/share/mpqc/2.3.1/basis/sto-3g.kv.

‘> Reading file /u/ac/grw/mpqc/share/mpqc/2.3.1/basis/sto-3g.kv. 4

v

< »
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Module 5: Fortran

+ Objective
+ Learn what Photran is and how it compares to CDT
+ Learn how to create a Fortran MPI application

+ Contents
+ Overview of Photran
+ Module 3 redux (in Fortran)
+ Differences between Photran and CDT
+ Pointers to online documentation for Photran
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File Edit Navigate Search Project Run Window Help
e ey 5
019 L WY YL

EE Fortran Projects &3 = 8 |NF 0= Outline &2

v % W W
. _module Mdataset “m
b EEMMFP = implicit none o ¥ W) Mdataset
¥ iz5>org.eclipse.photran-samp | v ) Tdataset
! Declare a Tdataset type to hold data poi

P < Binaries type :: Tdataset “  datapt
real 11 datapt(4,1000) - npts
integer it npts
,src-fortran-and-c real :: valsum(4) valsum

P src-fixed-form

b

P (] src-gaussian-elimination reat iovalsum(4) valsum
) L real troxXysum(3)

D (f src-includes logical :: has np(2) xysum

P

 src-language-features end type Tdataset has_np

¥ @1 >src-line-fitting end module Mdataset

: i i program BstFitProj PhOtran

.cvsignore 1.1 (ASCI .
b 68 src-modules ®  use Mdataset * http://www.eclipse.org/photran

C ‘ * Official Eclipse Foundation project;
@ Make Targets 2 = B |[Z. Problems 2 . Console| Properties part of the Parallel Tools Platform (PTP)
5 M |26 errors, 0 warnings, 0 infos * 20,000 downloads/release (2007)

c ) Description
P =5 org.eclipse.photran-samples

b =S whatever2 @ Derived type definition has no componeihd Supports Fortran 77 90 95 and 2003
® * Built on CDT; largely similar to it
@ FILE tag must be of type CHARACTER
@ lllegal preprocessor directive ° Primary Contributor: UlUC
* Contrib’s from Intel, IBM, LANL, & others
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" Fortran - bStfIt.f90 - Eclipse Platform 7" =|(=l[x]

File Edit Navigate Search Project Run Window Help

57 Q “ 0% | B 45 ¥o P =] ’@Fortran}

EE Fortran Projects &2 F 5= Qutline 2 =8

L R
B

. _module Mdataset
P E>MMFP = implicit none ¥ iy Mdataset

=L .
¥ [z >org.eclipse.photran-sam ¥ ) Tdataset
- J e d ! Declare a Tdataset type to hold data points

w

type :: Tdataset datapt

Fortran real :: datapt(4,1000) ® npts

integer ionpts >

M ;1 valsum(4) valsum
Editor & , o
troXysum(3) o

i B i : Xysum
Outlll‘le 1 logical 11 has np(2)

ge-features end type Tdataset ¥ has_np

¥ @i =src-line-fitting end module Mdataset v @ BstFitProj

v >bstfit.foC . ¥ LoadDataSet

) _ - program BstFitProj )
5 .cvsignore 1.1 (ASCI ¥ ShowDataPoints

P (% src-modules j (X] use Mdataset | SquareDistances [ﬂ
< J D ] , , K J D

(@ Make Targets &2 = B |[Z. Problems 2 . Console| Properties > ¥ =08

D % 26 errors, 0 warnings, 0 infos
= N

g ) Description Resource
P =5 org.eclipse.photran-samples = 5 —

P =Ewhatever2 @ Derived type definition has no components bu9138221.fu

@ FILE tag must be of type CHARACTER bugl18974.f

@ lllegal preprocessor directive bugl118961.f/, |
)

ey




‘7 hello.f

a orn :r‘i DUIrcC Nl
integer :: i1f = 3
integer :: end = 5
character :: endif = "Hello"

Eh «

if (if .gt. end) then Context-
print *, &
Rendif Aware

endtf Highlighting
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“Fortran - bstfIt.f90 - Eclipse Platform ' =|(=l[x]

File Edit Navigate Search Project Run Window Help

fr O Qv | Fr 6 B | ® 4 % ¢ = | B Fortran|
fE Fortran Projects 82 = 8 FF 5= Qutline 2 =8
|
m % W W

P ESMMFP : [E < ) Mdataset
v ) Tdataset

<

¥ [5=org.eclipse.photran

P < Binaries support

P (] src-fixed-form

hold data points
datapt

(4,1600) Y npts

, P w
(1} src-fortran-and-c ——vaTsam(4), valsum

“  wvalsum

) troXysum(3) °
4 src-includes logical :: has np(2) Xysum

(1 src-language-features end type Tdataset ¥ has_np

end module Mdataset ¥ & BstFitProj

D) ¥ LoadDataSet

) - : program BstFitProj )
5 .cvsignore 1.1 (ASCI ¥ ShowDataPoints

b
P (] src-gaussian-elimination
b
b

< i) =src-line-fitting

A src-modules v|!® use Mdataset | ®  squareDistances ¥/
<] l D («] . < _ D

(@ Make Targets &2 = B |[Z. Problems 2 . Console| Properties > ¥ =08

D % 26 errors, 0 warnings, 0 infos
— N

P . Description Resource
P =5 org.eclipse.photran-samples v . —

P =Swhatever2 @ Derived type definition has no components bugl38221.f
(X) J

@ FILE tag must be of type CHARACTER bugl18974.f
@ lllegal preprocessor directive bugl18961.1[5|

)

ey
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“Fortran - bstfIt.f90 - Eclipse Platform ' =|(=l[x]

File Edit Navigate Search Project Run Window Help

&) ~ & * e |3
a1 ¥y Qv Q- v &9 ; o P 5= ’L@Fortran}

fE Fortran Projects &2 = 8 FF 53 5= Qutline 2 =8

module Mdataset [« |m
, ' -~ '
b EEMMFP implicit none [E ¥ ) Mdataset
v ) Tdataset
! Declare a Tdataset type to hold data points
D OBinal‘ieS 'type :: Tdataset @ datapt
real it datapt(4,1000) ° npts
integer it npts

¥ iz5>org.eclipse.photran-samp

P (] src-fixed-form

, P w
(1} src-fortran-and-c -+ valsum(4). valsum

. L troXysum(3)
i src-includes logical :: has np(2) Xysum

(1 src-language-features end type Tdataset ¥ has_np

P
P ) src-gaussian-elimination 3 B valsum
P
P

¥ @i =src-line-fitting end module Mdataset BstFitProj

[> £ 1.1 ! LoadDataSet
program BstFitProj

j.cvsignore 1.1 (ASCI
A src-modules »]|/® use Mdataset

l l D [

(@ Make Targets &2 = B |[Z. Problems 2 . Console| Properties

D % 26 errors, 0 warnings, 0 infos
— N

~C . Description
P =5 org.eclipse.photran-samples ; -

P =Swhatever2 @ Derived type definition has no components

®

@ FILE tag must be of type CHARACTER bugl18974.f
@ lllegal preprocessor directive bugl18961.1[5|

)

ey
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=10/ x|

File Edit Mavigate Project Run Window Help
SRAERSIICNE S AR 7| $oebug ToFortian >

%5 Debug £2 = O || ®=variables £2 . Breakpo... Registers | Memory |2 = O
59 (P () DD | I v ¥ =k O | % R v

-1-3F SayHello-Photranz. 1-win32-g95 [Fortran Local Applic: « ¥ language
--&@ Cygwin GDB Debugager (2/15/05 11:32 AM) {Suspe
—-47® Thread [1] (Suspended)
= 3 speak_.474{) at sayhello.f90:86 «|

= 2 MAIN_() at sayhello.F90:71 hd i
| S| Debugging
(GDB GUI)

call RANDOM HUMBER (rand)

if (rand > .7) then
language = 'Greesk!’

else if (rand > .3) then
language = 'Polish'

else
language 'Japanese’

end if
<]

El console 82 . Tasks ()
SayHello-Photran2, 1-win32-g95 [Fortran Local Application] Debuager Process (2[15/05 11:32 AM)
ygdrive/c/WINDOUS/system32/kernel3z2.dll

.
F ey
Jeygdrive/c/Documents and Settings/draganch/Desktop/eclipse/workspace/3

Jevgdrive/ o/ WINDOWS/ system3z2/advapiiz .dll

\Writable Smart Insert 86:1

5
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Using Photran

+ It’s just like using CDT...
+ Similar New Project wizards
+ Similar build procedure
+ Similar launch/debug procedure

...but not exactly

+ Configuring fixed vs. free form file extensions
+ Different editor features

+ Different advanced features (Module 7)
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Fortran

Switch to @/ 04 Perspective

UL Help
New Window

+ Only needed if
you're not
already in the Open Perspective
perspective Show View

>
>

%> Debug
&Y Team Synchronizing

Customize Perspective...

Save Perspective As... ‘ l

Reset Perspective... \
Close Perspective Hig)C/C++
Close All Perspectives

+What Perspective IRadEts

e CVS RepYsitory Exploring
.'*J.-\.
%> Debug

. . #FindBugs
am in in? U o e i
See Title Bar &7 Java (default)

g _
¢ Java Browsing
ngJava Type Hierarchy
«J=Plug-in Development

® 00

@ Eclipse SDK

i S | #5 Or Qer Qv | EY &8 Y | O~
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| Fortran -
Creating a @/C% Application

Steps: Fortran
+ Create a new S project

4+ Edit source code
4+ Save and build

& Fortran - Eclipse SDK

File | Edit Navigate Search Run Project Window Help
New Alt+Shift+N » | ¢ Fortran Project

Open‘F}(... 7] Project... \

1% Source Folder
Y Folder

" Source File

PTP Tutorial
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Fortran |
New @ Project Wizard

Fortran Project

Create a new MPI project

+ Fi Ie > N ew > W Fo rtra n Create a Fortran project of the selected type
(see prev. slide) Project -

+ N a m e th e p rOj ect ™ Use default location

Location:

) MYHel IOPrOjeCt, Choose file system: There are

+ Project type: Q “Managed BU||d”
> (= Executable ;— p I"O_] eCtS fo r

» (= Shared Library
> & Static Library Fortran too...
& Executable (Gnu Fortran) t
& Executable (Gnu Fortran on MacOS X)
&> Static Library (Intel(R) Fortran) t . .
& Executable (Intel(R) Fortran) 4 ...but this is a

& Shared Library (Intel(R) Fortran)

Hello wo rld Fortran <> Executable (XLF Fortran on MacOS X) :i Makeflle proJeCtl

- ) v_:a;;h;yp;oije:; where you
Project and hit Next o tieloora C++ rojec maintain the

@ Hello World Fortran Makefile Project

On Basic Settings page, 5 AT MR Makefile

fill in information for your
new project (Author
name etc.) and hit

Finish

) ( cancel ) Finish )

Module 5
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Fortran Proljects
Frojecveipiorer View

+ Represents user’s data

+ It is a set of user defined
resources
+ Files _.
+ Folders » 3 Binaries

@, Fortran Projects &3

» [n)} Includes

+ Projects v B sre

+ Collections of files and » [F] MyFortranProject.f90
fOIderS = L;‘*bln

+ Plus meta-data
+ Resources are visible in
the PHEC BXANA Al View
Fortran Projects
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Editor and Outline View

®00 Fortran - MyHelloProject/src/MyHelloProject.f90 - Eclipse SDK

+ Double-click on f9e G @ B KR ©r 3 O @ Qur | B 69+ = Eroran
fg Fortranpr 83 = B || [F] MyHelloProject.f30 53 = O || 5= outline 83 =8

source file to - e

O p e n ; e d ito r L-faJltﬂzHFI\o?roject use mpi <Free Form Source>

B . ..
%5, Binaries implicit none ) (anonymous)

FO rtra n 8 r integer, parameter :: LEN = 100

» [F] MyHelloProject.f90
» (= bin }nteger
integer
; ger

.cproject

+ O tl H H H = .préje_ct integer :: source
u Ine VIeW IS ® Makgfis integer 11 dest

integer 1! tag

Shown for fi |e in character(len=LEN) :: message

integer 11 status(MPI_STATUS_SIZE) ! re

editor 4 )

{2 Problems 3 ] Console| &2, Fortran Declaration ¥ =08

0 items
Description A |Resource Location

Writable




| Project | Window Help

Close Project

Build All Ctrl+B
Build Configurations »
Build Project

Build Working§

Clean...

v Build Automatically

paratel—toois—platiform

Et Cetera

+ Building (compiling) is identical

Tip: Are compile errors
not shown in the
Problems view?

+ Right-click on the
project in the Fortran
Projects view, and
choose Properties

Expand Fortran
Build » Settings
Switch to the Error
Parsers tab

Are Photran’s error
parsers checked? If
not, click Check all

Click OK and re-build
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Et Cetera

+ Creating a launch configuration is identical
(Suggestion: Uncheck Stop on startup at main in the Debugger tab)

= Run Configurations

Tip: Is your binary not
listed when you create a
launch configuration?

+ R|ght'C||Ck on the i x‘ I Name: FortranOnWindows Debug
prOJeCt In the Fortran fype Jter text [£] Main . (9= Arguments | g Environment | >z

- . c WC/C++ Application
PI‘O_] ECtS VleW, an d clipse Application Fortran Application:

Choose Propertles 18l Fortran Local Application Debug/notepad.exe | Search Project... Browse...

[ ] FortranOnWindows D

EXpa N d FO I‘tl‘a ] ¥] Java Applet Project:
B 1] i Id > Setti ng S {31 Java Application FortranOnWindows Browse...

Ju JUnit
Switch to the Binary Ju Jnit Plug-in Test

Pa rsers ta b 4 0SGi Framework
Enable auto build Disable auto build

Make sure the pa rser @ Use workspace settings Configure Workspace Settings
for your platform is

checked

PE = Windows .
E”: — LinUX Filter matched 10 of 10 items

Mach-O = Mac 0S X @
+ Click OK ;

Create. manage. and run configurations

Build (if required) before launching

LU

Module 5 PTP Tutorial
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Et Cetera

+ Debugging is identical
+ Launching a parallel application is identical

+ Debugging a parallel debugging is identical

PTP Tutorial




paratel—toois—platiform

Differences (1): MPI Project Wizard

+ In the MPI Hello World C Project,

the MPI compiler is set in the project settings...
(See “Changing the C/C++ Build Settings Manually” in Module 3)

+ ...but in the MPI Hello World Fortran Project,
the MPI compiler is set in a Makefile.

.PHONY: all clean

all: MyHelloProject. f90
—02 -g -0 bin/MyHelloProject \
rc/MyHelloProject. f90

clean:
rm -f bin/MyHelloProject *.mod
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Differences (2): Content Assist

+ Content assist is disabled by default.

(So are Declaration View, Hover Tips, Fortran Search, and refactorings.)
You must specifically enable it for your project.

nght'C“Ck on the " type filter text ) Analysis/Refactoring

prOJeCt |n the Fortran Resource

AnyEdit Tools To enable Open Declaration, Find All References, the Fortran Declaration

1 i i view, content assist, and refactoring in Fortran programs, check the
Projects view, and Builders

»C/C++ Build following box. A program database (index) will be updated every time

ChOOSG PI‘OpeI'tieS »C/C++ General a Fortran file is created or saved.

p Fortran Build !Z[ Enable Fortran analysis /refactoring

¥ Fortran General = . .
EXpa nd FO rtra n > V| Enable Fortran Declaration view

Ana IySiS/ Refa cto ri ng Paths and symbols M Enable Fortran content assist (Ctrl+Space)

;Lc:iegeii;ersee'::ﬁfgs |Zf Enable Fortran Hover tips
Check Enable Fortran '
a na IySiS/ refa CtO ri ng The following specify the paths searched for modules

and INCLUDE files during analysis and refactoring.
These MAY BE DIFFERENT from the settings used by

CI |Ck OK your compiler to build your project.

Folders to be searched for modules, in order of preference:

Close and re-open any IMyHelloProject
Fortran editors

New...

( Cancel \ ( OK )
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Differences (3): Source Form

+ Fortran files are either free form or fixed form
+ Determined by filename extension
+ Extensions are set in the workspace preferences

+ Defaults:
Fixed form: .f fix for fpp
Free form: .fO3 .fo95 .fo0 f77

+ Many features will not work if filename
extensions are associated incorrectly

(Outline view, content assist, Fortran Search, refactorings, Open Declaration, ...)
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Differences (3): Source Form

Set fixed/free form filename extensions in the preferences

2d(,1 File Edit Refa
About Eclipse SDK

Preferences

Preferences...

Content Types

vCeneral

. . P Appearance

Hide Eclipse SDK  3H Capabilities Content types:

Hide Others \3H \ Compare/Patch » Binary File

Show All Content Types Java Class File

. . » Editors wText

Quit Eclipse SDK  3Q Keys Assembly Source File

» Network Connectic » C Source File
Perspectives

See 'File Associations' for associating editors with file types.

wFortran Source File

+ NaV|gate the tree Search Fortran Source File - Fixed Format

P Security Fortran Source File - Free Format

tO General > p Startup and Shutdc /

Web Browser File associations

Content Types » Workspace *f03

VvAnt *f77

Expand Text» v Editor “.f90

Content Assist *.fas

Fortran Source Formatter
File Templates

Runtime
vC/C++

Select Fixed or S
Free Format and @) (
set associations

Default encoding:

Cancel ) (

Module 5 PTP Tutorial
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Differences (3): Source Form

Outline view displays expected source form of file in editor
(according to the workspace preferences)

]é Fortran - FortranOnWindows/test.f80 - Eclipse SDK E
File Edit Refactor Navigate Run Search Project Window Help

EE Fortran Proj &2 = B || [F) test.f90 2 “{ || 5= Outline 52 = B8
=F = ’ : 1 AL

% FortranOnWindows <Free Form Source>

(= Debug N | @ test
[F] test.f90 program test
] implicit none
| .cproject

u et print *, "Hello"
.projec

end program test

I Attempting to open a file
with the “wrong” editor

(right-click » Open With)
[2! Problems &2 El Console Li issues a Warning

0 errors, 4 warnings, 0 others

A

Description Resource Path

& Warnings (4 items)
<

Writable Insert

PTP Tutorial
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For More Information

+ Module 7: Fortran Search, Refactoring

+ Photran online documentation
linked from http://www.eclipse.org/photran

+ User’s Guide
General introduction, basic features

+ Advanced Features Guide
Features requiring analysis/refactoring to be enabled

+ Online tutorial: Compiling and running the

Parallel Ocean Program using Photran and PTP
linked from http://wiki.eclipse.org/PTP/photran/tutorials

Module 5
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Module 6: Parallel Debugging

+ Objective

+ Learn the basics of debugging parallel programs with
PTP

+ Contents
+ Launching a parallel debug session
+ The PTP Debug Perspective
+ Controlling sets of processes
+ Controlling individual processes
+ Parallel Breakpoints
+ Terminating processes

Module 6




+ Use the drop-down next to

the debug button (bug
icon) instead of run button

+ Select the project to launch Debug As b

Debug Configurations...

+ The debug launch will use Organize Favorites...
the same number of SMachines 52 & | o - = 0

processes that the normal Open_MPI@abe.ncsa.uiuc.edu: Open_MPl@abe.ncsa.uiuc.edu - Root [40]

4 -~ Open_MPl@abe.ncsa.uiuc.edu
launch used (edit the H -

Debug Launch 2o IS I I I o

Configuration to change) rAoEnnoono-

Node Attributes Process Info
Attribute Value

Name node0

Node Number 0

Node State upP

Open MPI number 1




+ Parallel Debug
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The PTP Debug Perspective (1)

00 PTP Debug - shallow/main.c - Eclipse SDK

$50 O Qv Qv | O |35 |6 47+ | &1+ 51 0 oo

£ parallel Debug 2 13 R {F~
Open_MPl@abe.ncsa.uiuc.edu: default:job0 - Root [4]
£3 job0 @ » -+ >

view shows job
and processes
being debugged

Name
& arge
» <& argv
>»&p
75 Debug 2 >Su
v 8} shallow [Parallel Application]
v &2 Process 0

rov

Value

1

£ BEPTP Debug 888 PTP Runtime EC/C++

{z}» = B || % Breakpoints |4 Expressions )= Variables £

t | e

bffff248
[0-16]
[0-16]
[0-16]

Debug view shows

¥ ,® Thread [1] (Suspended)

threads and call
stack for individual
processes

= 1 main() main.c:49 2ccS

lg) main.c &
float
float
float
float
float
float

h[n][m];

z[n][m];

dummy1[m];

dummy?2[n][m];
pi=4.*(float)atan((double)l.);
tpi=pi+pi;

float di=tpi/(float)m;

float dj=tpi/(float)n;

int i, j, chunk_size, nxt, prv;

Source view
shows a current
line marker for all
processes

int master_packet[4];
float p_start[m];
float u_start[m];
float  v_start[m];
float psi_start[m];
float pold_start[m];
float
float

uold_start[m];
vold_start[m];

El console| 0 Memory| €] Error Log 82 _[Z. Problems

&% Outline 2

Master SDM control

R o %
math.h
mpi.h
stdio.h
decs.h

+ worker() : void
+ setup_res() : MPI_Dataty

main(int, char*[])
setup_res() : MPI_Dataty
update_global_ds(MPI_C




paratel—toois—platiform

The PTP Debug Perspective (2)

+ Breakpoints view
shows breakpoints
that have been set
(more on this later)

Variables view
shows the current
values of variables
for the currently
selected process in
the Debug view

Outline view (from
CDT) of source
code

PTP Debug - shallow/main.c - Eclipse SDK

TR A 2> K & ROl i+ Vv v il SR AT 5 ZEPTP Debug 288 PTP Runtime [EC/C++

ol Nehug 52 e p— = :’ % Breakpoints |4 Expressions | = Variables 23

Open_MPl@abe.ncsa.uiuc.edu: default:job0 - Root [4]
£3 job0 Name
<& arge
! & argv
>»&p
?;;Debuggg o is 3 {‘(, ¥ =8 > &S u
8} shallow [Parallals
F#PPGCess 0

Value

1
bffff248
[0 - 16]
[0 - 16]
[0 - 16]

v /® Thread [1] (Suspended)

= 1 main() main.c:49 2cc5S

Ll main.c &
float h[n][m];
float z[n][m];
float dummy1[m];
float dummy2[n][m];
float pi=4.*(float)atan((double)l.);
float tpi=pi+pi;
float di=tpi/(float)m;
float dj=tpi/(float)n;
int i, j, chunk_size, nxt, prv;

int master_packet[4];
float p_start[m];
float u_start[m];

2= Outline %

BN o %
math.h
mpi.h
stdio.h
decs.h

+ worker() : void

+ setup_res() : MPI_Dataty
main(int, char*[])
setup_res() : MPI_Dataty
update_global_ds(MPI_C

flogd T
float psi_start[m];
float pold_start[m];
float uold_start[m];
float  vold_start[m]:

El console| 0 Memory| €] Error Log 88 _[Z Problems

Master SDM control




The buttons |n the PTP Debug - shallow/main.c - Eclips

Parallel Debug View QV w | 45 Qv Qv Qe ? = | A D N
COI’]tI‘O| groups Of 7 Parallel Debug &8 P 3 b - , R & 0|8 i )

p rocesses Open_MPl@abe.ncsa.uiuc.edu: defa

Click on the Step Over
button

Observe that all process

%% Debug &2
v i} shallow [Parallel Application]

iCOﬂS Change tO green, v &2 Process 0
then back to ye“OW v, Thread [1] (Suspended)

Notice that the current
line marker has moved to (Sl

= float z[n][m];
the next source line Flot  dvmmyi ()
float dummy2[n][m];
float pi=4.*(float)atan((double)l.);
float tpi=pi+pi;
float di=tpi/(float)m;
float dj=tpi/(float)n;
int i, j, chunk_size, nxt, prv;

int master_packet[4];
float p_start[m];
float  u_start[m];
float v_start[m];
float psi_start[m];
float pold_start[m];
float uold_start[m];
float  vold_start[m]:




L

+

+

The buttons in the
Debug view are used
to control an
individual process, in
this case process 0

Click the Step Over
button

You will now see two
current line markers,
the first shows the
position of process O,
the second shows the
positions of processes
1-3

000

PTP Debug - shallow/main.c - Eclipse SDK

o | I Q@@ |O- 32| B A - 2 BT

£ parallel Debug 52 I R
Open_MPl@abe.ncsa.uiuc.edu: default:job0 - Root [4]

0 A A 4 Name

& EEPTP O

& 0|8 - {z}v = B % Breakpoints |’

%5 Debug &3
v i} shallow [Parallel Applicatiend
v ;580se O uspended)

v 1 Thread [1] (Suspended)

= 1 main() main.c:51 2cde

L] main.c 22

float h[nJ[m];

float z[nJ[m];

float dummyl1[m];

float dummy2[n][m];

float pi=4.*(float)atan((double)l.);
float tpi=pi+pi;

float di=tpi/(float)m;

float dj=tpi/(float)n;

int i, j, chunk_size, nxt, prv;

int master_packet[4];
float p_start[m];
float u_start[m];
float v_start[m];
float psi_start[m];
float pold_start[m];
float uold_start[m];
float vold_start[m]:
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Process Sets (1)

+ Traditional debuggers apply operations to a single
process

+ Parallel debugging operations apply to a single process
or to arbitrary collections of processes

+ A process set is a means of simultaneously referring to
one or more processes
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Process Sets (2)

+ When a parallel debug session is first started, all
processes are placed in a set, called the Root set

+ Sets are always associated with a single job
+ A job can have any number of process sets
+ A set can contain from 1 to the number of processes in
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Operations On Process Sets

+ Debug operations on the
Parallel Debug view
toolbar always apply to the |[Eliokais TR

Open_MPl@abe.ncsa.uiuc.edu: default:job0 - Root [4]
current set:

+ Resume, suspend, stop,
step into, step over, step
return -
a—+shallow [Parallel A6

+ The current process set is v &2 Process 0
v ,® Threag’[1] (Suspended)

listed next to job name = * main() main.c:49 2¢c5
along with number of

processes in the set

+ The processes in process
set are visible in right hand

Root set = all
part of the view

Processes
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Managing Process Sets

+ The remaining icons in the toolbar of the Parallel
Debug view allow you to create, modify, and delete
process sets, and to change the current process set

Create set Remove
from set

7% parallel Debug &3 I . 2R & 0 S {y~ Chan e
Open_MPl@abe.ncsa.uiuc.edu: default:;job0 - Root [4] g

£ job0 @5+ » current set

#;} Debug (4 1= D D _,_,j_ {} 3 De I ete

v EH::‘.hallow [Parallel Application] Set
v &2 Process 0
v Thread [1] (Suspended)

= 1 main() main.c:49 2cc5




Select the processes 4 Parallel Debug 2 L1 EXS
Open_MPl@abe.ncsa.uiuc.edu: default:job0 - Root [4]

you want in the set by [
clicking and dragging,

In thlS Case, the IaSt e Create a new set name

th ree k Please enter the new set name.
C||Ck on the Create #Tshallow [Parallel Appli ke

v 52 Process 0 (Suspen

Set button v ® Thread [1] (Susj’

1 main() main

Enter a name for the
set, in this case
workers, and click OK

You will see the view
change to display only
the selected processes

7 parallel Debug &3 B .| 2D & O
Open_MPl@abe.ncsa.uiuc.ediingdefault:job0 - workers [3]
£3 job0 A A 4

( Cancel ) ( oK )

Frg | ®-=0
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_

w53

-

Stepping Using New Process Set

With the workers Set PTP Debug - shallow/main.c - Eclipse SDK
i | O @y O 2 | v il Py 5 ¥EPTP Debug 25 PTP Runtime [EC/C++

aCtlveI CI ICk the Step 7 Parallel Debua 52 By = & 0|8 " (* 4 | & = 8% Breakpoints |6 Expressions 9= Variables 52 =8
Open_MPl@abe.ncsa.uiuc.edu: default:job0 - workers [3] A= ;; e
Over button T , ,

You will see only the
first current line T — T kLA
marker move

Step a couple more
tlmeS [¢ main.c 8 = O|[ & Outline & =B

You Should see tWO Ilne float  di=tpi/(Float)m; u f"z:\f o
markers, one for the S g | G

float dj=tpi/(floatdn; 21 math.h
float  p_start[m]; ® decs.h

int i, j, chunk_size, nxt, prv;
H float  u_start[m]; ++ ker() : void
single master process o Vi 8 wokerhivold
_ P @ main(int, char*[])
and one for the 3 Float  pold.start[nl; o setup res0: MP| Dataty
_ H ] date_global_ds(MPI_C
worker processes i rocens ™ T

MPI_Datatype * res_type;

-

»

A
» MPI_Init(&argc, &argv); 1 ==

— N i -
El console | 0 Memory| € Error Log 8 |2 Problems & H,v x X v =g

Master SDM control
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Process Registration

+ Process set commands apply to groups of
processes

+ For finer control and more detailed
information, a process can be registered and
isolated in the Debug view

+ Registered processes, including their stack
traces and threads, appear in the Debug view

+ Any number of processes can be registered,
and processes can be registered or
un-registered at any time




Registering A Process

+ To register a process,

double-click its process
icon in the Parallel
Debug view or select a
number of processes and
click on the register
button

+ The process icon will be
surrounded by a box and

the process appears in
the Debug view

+ To un-register a process,

double-click on the
process icon or select a
number of processes and
click on the unregister
button

Module 6

Open_MPl@abe.ncsa.uiuc.edu-"tre
£3 job0

%5 Debug &3
v 58} shallow [Parallel Application]
v &2 Process 0 (Suspended)
v i Thread [1] (Suspended)
1 main() main.c:51 2cde
v &2 Process 3 (Suspended)
v ,® Thread [1] (Suspended)
= 1 main() main.c:67 2d1la

l¢ main.c 23

PTP Debug - shallow/main.c - Eclipse SDK

Groups (sets)
of processes

i T |

Individual
(registered)
DIroCcesses
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Current Line Marker

+ The current line marker is used to show the
current location of suspended processes

+ In traditional programs, there is a single
current line marker (the exception to this is
multi-threaded programs)

+ In parallel programs, there is a current line
marker for every process

+ The PTP debugger shows one current line
marker for every group of processes at the
same location
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Colors And Markers

.| main.c &3
+ The highlight color depends on int piay
the processes suspended at
th at | I n e : :gi:égméfi‘?;gzﬁpifzgaalwosuo, &proc_cnt);
MPI_Comm_rank(MPI_COMM_WORLD, &tid);
+ Blue: All registered process(es) .

[ H {
* orange' A” unregIStered fprinvtf(siv;derr', "must have at least 2 processes, not %d\n", proc_cnt);
process(es) MPI_Finalize();

return 1;

+ Green: Registered or unregistered d
process with no source line (e.qg. o
suspended in a library routine)

Multiple processes marker

The marker depends on the
type of process stopped at that Registered process marker
location

Ed Un-registered process marker

Hover over marker for more

details about the Processes Multiple markers at this line

suspend at that location -Suspended on unregistered process: 2
-Suspended on registered process: 1

Module 6
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Breakpoints

+ Apply only to processes in the particular set that is

active in the Parallel Debug view when the breakpoint
is created

+ Breakpoints are colored depending on the active
process set and the set the breakpoint applies to:

+ Green indicates the breakpoint set is the same
as the active set.

+ indicates some processes in the breakpoint set are
also in the active set (i.e. the process sets overlap)

+ Yellow indicates the breakpoint set is different from the
active set (i.e. the process sets are disjoint)

+ When the job completes, the breakpoints are
automatically removed

else{
| print
MPI_Final
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Creating A Breakpoint

+ Select the process set that
the breakpoint should apply

to, in this case, the workers
set

Double-click on the left edge
of an editor window, at the
line on which you want to set
the breakpoint, or right click
and use the Parallel
Breakpoint» Toggle
Breakpoint context menu

+ The breakpoint is displayed
on the marker bar

e 00 PTP Debug - shallow/main.c - Eclipse SDK

] =0 | loro -'t;' @";“' '(-’u' 0' _E = A | ’:! v ~v
2% parallel Debug & B . 2R
Open_MPl@abe.ncsa.uiuc.edu: default:;job0 - workers [3]

£3 job0 19 & [@] Name
y

& 0 |G O~ ¢ = | &~ = O|[% Break

% Debug 22
v & shallow [Parallel Application]
v &2 Process 3 (Suspended)
v 4@ Thread [1] (Suspended)
1 main() main.c:71 2d60

|| main.c 23

MPI_Finalize();
return 1;

}
o if ( (n|% (proc_cnt - 1)) 1= @)
{

if ( tid == 0 )
fprintf(stderr, "(number of processes - 1) must be a multiple of %d\n",

MPI_Finalize();
return 1;

}

if (tid 1= @) {
worker();

El console | 0 Memory | €] Error Log &2 2. Problems

Writable Smart Insert 78 : 12




Click on the Resume button
in the Parallel Debug view

In this example, the three
worker processes have hit the
breakpoint, as indicated by
the yellow process icons and
the current line marker

Process 0 is still running as its
icon IS green

Processes 1-3 are suspended
on the breakpoint

as | B2 A

- & 0= {y~
Open_MPl@abe.ncsa.uiuc.edu: default:job0 - Root [4]

£ job0 B+ + @

%5 Debug &3

Process 3 (Suspended)
/2 Thread [1] (Suspended: Breakpoint hit.)
= 1 main() main.c:78 2da5
v &@Process 0
4 Thread [1] (Running)

L] main.c 23
MPI_Comm_rank(MPI_COMM_WORLD, &tid);

if ( proc_ent < 2 )

{
fprintf(stderr, "must have at least 2 processes, not %d\n", proc_cnt);
MPI_Finalize();
return 1;

}

if ( (n ¥ (proc_ecnt - 1)) =0 )
{

if ( tid == 0 )
fprintf(stderr, "(number of processes -

MPI_Finalize();

El console| O Memory Q Error Log & |2 Problems

1) must be a multiple of %d\n", n);



The Step buttons are only

enabled when all processes

in the active set are € Parallel Debug 23 L
Suspended (ye”OW icon) Open_MPl@abe.ncsa.uiuc.edu: default:job0 - Root [4]

: . A £2job0 0 [¥]
In this case, process 0 is still o
running

PTP Debug - shallow/r

Switch to the set of ] w | B Q@ @y [OE B A

suspended processes (the 3 i 2. R 0|8 O |8
Workers Set) Open_MPl@abe.ncsa.uiuc.edu: default:job0 - workers [3]
£3 job0 19 9P

You will now see the Step
buttons become enabled
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Breakpoint Information

+ Hover over breakpoint icon
+ Will show the sets this breakpoint applies to

+ Select Breakpoints view
+ Will show all breakpoints in all projects

% Breakpoints £3 . S Expressions 9= Variables
R# W |HEZT
4 & main.c [line: 78] {job0:workers}

- '—:§
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Breakpoints View

e ‘—? ‘\\

+ Use the menu in the breakpoints view to group
breakpoints by type

+ Breakpoints sorted by breakpoint set (process
set)

% Breakpoints &3 . 7 Expressions 9= Variables

RPN | HEZG |
M v » workers Add Event Breakpoint (C/C++)...
T4 & main.c [line: 78] {job0:workers}

% 1 Breakpoints

oo Select Default Working Set... &% 2 Breakpoint Types

oo 3 Breakpoint Working Sets
4 Files
# Show Qualified Names
=% 6 Projects
= 7 Resource Working Sets
- 8 Advanced...

Working Sets...

o Focus on Active Task
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Global Breakpoints

+ Apply to all processes and all jobs

+ Used for gaining control at debugger startup
+ To create a global breakpoint

+ First make sure that no jobs are selected (click in white
part of jobs view if necessary)

+ Double-click on the left edge of an editor window

+ Note that if a job is selected, the breakpoint will apply to
the current set

if (my _rank '=0) {
/* create message */

Sprintf(message, "Greetin
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Terminating A Debug Session

+ Click on the Terminate
icon in the Parallel EParalichBebug-5
Debug view to OpenPl@abe.ncsa.uiuc.edu: defa:l't:jobo - Root [4]
. P ¢ v -
terminate all processes
in the active set

Make sure the Root set
is active if you want to
terminate all processes

% Debug 3

5} <terminated>shallow [Parallel Application]

00 PTP Debug - shallow/main.c - Eclips
o | B Qv Qv [O 52| E v Sl =
5% parallel Debug &2 B W 3G & O | = {F~ {z1+ = 0O

YO u Ca n a I SO u Se th e g;:g:)/lPl@abe.ncsa.uiuc.edu: de;a:jo'bor— R:ot (4]
terminate icon in the

Debt_lg view to — ——
te rm I n ate the Cu rre ntly v &% shallow [Parallel Application]

v &@Process 0
SEIGCted process v ,® Thread [1] (Suspended)

Module 6
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Module 7: Advanced Development

+ Objective
+ Explore some of the advanced features of Eclipse and PTP

+ Contents
+ Advanced Eclipse Concepts (generic, not CDT/PTP)
+ Refactoring and Search in Fortran and C/C++
+ Parallel Language Development Tools: MPI, OpenMP, UPC
+Special Tools for parallel development
+ Remote Development

Module 7
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Advanced Eclipse Concepts

+ Perspectives, views and customizing
+ Workbench Preferences

+ Version Control

+ Task Tags

Module 7
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Customizing Perspectives

+ Items such as shortcuts, menu items and views may be
customized

+ Window» Customize Perspective...
+ Save changes
+ Window» Save Perspective As...
+ Close Perspective
+ Right-click on perspective title and select Close

+ Reset Perspective

+ Window» Reset Perspective resets the current
perspective to its default layout

Module 7
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Opening New Views

+ To open a view:
+ Choose Window» Show View » Other..
+ The Show View dialog comes up
+ Select the view to be shown
+ Select OK

= Show View

v (= General
Il Bookmarks
' Classic Search
Bl Console
@] Error Log
¥ Internal Web Browser
(2. Markers
‘&, Navigator
o= Outline
(2 Problems
€ Progress
75 Project Explorer
B Properties

Use F2 to display the description for a
selected view.

Cancel

Module 7
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Workbench Preferences

+ Preferences provide a way for you to
customize your Workbench

+ By selecting Window »Preferences... or
EclipseP» Preferences... (Mac)

+ Examples of preference settings

+ Use Emacs bindings for editor keys

+ Modify editor folding defaults
+E.qg., fold all macro definitions

+ Associate file types with file extensions
+E.g., *.f03 with the Fortran editor

+ Toggle automatic builds

+ Change key sequence shortcuts

+E.qg., Ctrl+/ for Comment

Module 7
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Version Control
(Ecllpse Team Support

C/C++ - cvs.ncsa.uiuc.edu/CVS/cluster2009/tutorial/samples/mpqc-2.3.1/src/bin/mpgc/mpqc.cc 1.1.1.1 - Eclipse SDK

=

o |G ey [ Gy [ R IO - Jr=S 21 v ileXo v FY [@3CVS Reposit... [gC/C++

+ Version control provided & T (LR o e Gl 22
through the Project

mpqc.cc
crances| New

Explorer view, in the

fi N
Jeonnigure  ahen With
, configure.il

Team context menu oo (2 Cony

| LICENSE 1,

4+ Provides familiar oo
actions: G| o

P n)t Includes

+ Commit... s | impor..

b Cysrc 4 Export...
> EEMyHeI[oProjec

+ Update 2 Refresh

Show in Remote Systems view
+ Also | d tasks:
SO eSS u Se a S S " Run As ! [ Properties | Progress |2 Problems | @] Error Log 83

+ Create/Apply Profile As
Synchronize with Repository
Patch... Compare With CCommit..  SeSreamee

Replace With Update ore  8/27/09 11:38 AM
WikiText Create Patch ore 8/27/09 11:38 AM

+ Tag as Version... | 1 Koply Patch... " e e

Properties

TG rsion...
i Tag as Version

+ B I'a n Ch amnm EX.dUde frgm bu.ild... % Branch...

Build Configurations .
Make Targets 4+ Merge...

* M e rg e S iwi;ﬁﬁ;oﬂr:&t{k;zroiranch or Version...
+ Add to .cvsignore...

Show History

Change ASCII/Binary Property...

Revert to Base

Module 4 Show Editors
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Team Synchronizing

®00 Team Synchronizing - CVS (mpqc): /mpgc/Makefile - Eclipse SDK

+ Accessed fro m th e O~ o | Qv e ’ R = W Y E9Team Synchr... [a CVS Reposit... g C/C++
Tea m > Syn C h ron ize f::::::’c‘:"ize e 5 mpqc.cc 1.1.1.1 © Makefile [ 2] README |50 Makefile 53
With Re poSito ry L Local File 1.1.1.1 © |Remote File 1.1.1.1

@ Make Compare Viewer v

context menu
Shows:

ey >build
¥ % src/lib/util /group
|.cf file.cc
£3 >.cproject
|=8% >.project

# Added comment

#
TOPDIR=.

SRCDIR
SRCDIR=$(shell pwd)

SRCDIR
SRCDIR=$(shell pwd)

LOCALMAKEFILE_OPTIONAL = yes

$(SRCDIR)/$(TOPDIR)/11ib/Globa]
LOCALMAKEFILE_OPTIONAL = yes

+ Files to be added

+ Files to be updated

+ Files to be committed

+ Files to be deleted

+ Merge conflicts |
Double-click on file to 8
show compare viewer
Operations can be

performed on individual
files or all at once

($(LOCALMAKEFILE_FOUND),yes)
$(SRCDIR)/$(TOPDIR)/11ib/GlobalMak:
SUBDIRS = lib bin src
($(LOCALMAKEFILE_FOUND),yes)
$(SRCDIR)/$(TOPDIR)/1ib/Globa]
SUBDIRS = lib bin src
install_devel::

$(SRCDIR)/$(TOPDIR)/1ib/GlobalSubl -$CINSTALL) $CINSTALLSCRIPTOPT) 1

install_devel:: clean::
-$CINSTALL) $CINSTALLSCRIPTOPT) libtod -rm -f depcheck.cc

clean:: distclean:: clean
-rm -f depcheck.cc -rm -f config.log
-rm -f config.status
distclean:: clean -rm -f libtool

-rm -f config.log
oy £ cowlso choabir
—— _— 4|p
[ History | v Tasks | |2 Problems $3 v =08
0 items
Description A |Resource Location

A

v

CVS (mpgc) [Incoming/Outgoing Mode)

Module 4
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Task Tags

l.c| MySampleProject.c &3

+ Task tags are identifiers in C/
C++ comments

+ TODO is a built-in task tag

+ The build locates task tags :
during compilation #inolade <stdio.n>
+ View task tags in Tasks View § 6
+ If it's not shown, Window
» Show View » Other...
Open General and select [Er=SEp. 5 s )

Filter matched 3 of 8 items

Ta S ks v ! Description Resource Path

MyTag a sample task tag MySamplePr... MySampleProject/src
MyTag like this MySamplePr... MySampleProject/src

+ CO n fi g u re yo u r O W n ta S k ta g TODO this is a built-in task tag MySamplePr... MySampleProject/src
in Window » Preferences

+ Under C/C++, select Task
Tags
Module 7
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Refactoring
and
Search
in Fortran and C/C++

Module 7
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Refactoring

(making changes to source code that don’t affect the behavior of the program)

RaTRetor Refactoring is the research
{R . . . .
T motivation for Photran @ Illinois
Extract Local Variable — Illinois is a leader in refactoring research

“Refactoring” was coined in our group

oublic We had the first dissertation...
. 13 oo
T Pr:_\?tceI:Sse to USE Statemet _ . ,
Add ONLY 0+ it = ...and built the first refactoring tool...
Minim‘ze : s Con5|5te -
ON :

...and first supported the C preprocessor

3 oc
interchand® - ’ , . ref ' f
ord Case o , Photran’s agendg. re actorm_gs or HPC,
Unify K:‘g‘ésolete oper language evolution, refactoring framework
Replac

Photran 5.0: 10-15 refactorings

Module 7

PTP Tutorial
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Rename Refactoring

+ Changes the name of a variable, function, etc.,

including every use
(change is semantic, not textual, and can be workspace-wide)

+ Only proceeds if the new name will be legal
(aware of scoping rules, namespaces, etc.)

C/C++ - MyHelloProject/src/MyHelloP1 + Select C/C++ Perspective or

File Edit Source Navigate Search Proje Fortran Perspective
_ Ri Shift+Alt+R .
: SREME W, A + Open a source file
+ Click in editor view on
declaration of a variable

+ Select menu item
Extract Procedure RefaCtor>Rename
1> For Extract Local Variable... ] 4+ Or use context menu

+ Enter new name
Module 7 PTP Tutorial

(Debugging)

EE Fortran Rename... \
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Extract Procedure Refactoring

+ Moves statements into a new subroutine, replacing the
statements with a call to that subroutine

+ Local variables are passed as arguments

ESIE)

Changes to be performed S ¢~
4 [V] @3 Extract Procedure
[v]@5! gauselim.f90 - org.eclipse.photran-samples/src-gaussian-elimination

e v + Sclect a sequence of statements
originaklﬁitoﬂ.r,ceir-ur_[-llll[-lj H REfaCt::;i;’:rce p * Select menu item

return

! Write the matrix, ong end subroutine vctwrt Refa Ctor > Ext ra Ct Proced u re- [ N ]

do irow = 1,nsize

write (0 0) ver| | YT in Fortran, or, in C/C++,

end do 2 RS
implicit none
return

| end subroutine vctwril o B0 G i ()] Refa Ctor > EXtra Ct Fu nction N

real :: bvct(10)
integer :: irow(10)

s oo s 4+ Or use context menu
+ Enter new name

PTP Tutorial
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Photran Implicit Refactoring

+ Introduce Implicit None adds an IMPLICIT NONE statement

and adds explicit variable declarations for all implicitly
declared variables

= Introduce Implicit None

S e — Rk + Introduce in a single file by
4 [V] @ Introduce Implicit None

[¥] @~ gauselim.f30 - org.eclipse.photran-samples/src-gaussian-elimination O pe n I n g th e fi | e a n d Se | eCti n g
B) gauselm 20 Refactor»Introduce IMPLICIT
Original Source Refactored Source N o N E &

program GaussianEliminati program GaussianElimiy -
-! Solve a linear system o implicit none
and Back Substitution integer :: indx
integer :: jndx

! SUBROUTINES: mtxrd,mtxw integer :: kndx IntrOduce |n mUItlple flles by

integer :: 1lndx

s sectere nin vy | selecting them in the Fortran

RERL :¢ bver(19) t and Back Substitu| Projects view, right-clicking on

. B ' the selection, and choosing
Refactor» Introduce IMPLICIT

e ) ook oo ] NONE...

PTP Tutorial
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CDT Rename in File

4+ Position the caret .c| example.cc 23
over an identifier. class {

public:

MyC1l :
+ Press Ctrl+1 -:);

(Command+1 on Mac).
int getX();

+ Enter a new name. void setX(int x);
Changes are private:
propagated within int x ;

. };
the file as you type.
int MyClass|::getX() {

return x ;

}
void MyClass|::setX(int x) {

X = X;

-

Module 7 PTP Tutorial
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CDT Extract Constant Refactoring

int main(void) {
®No Refactoring double intvalue-0.0}

The following changes are necessary to perform the refactoring. Source H
Rename...

Changes to be performed Declarations Extract Constant... \C
™M v @3 Changes \ - .

@ & WCprojectc - MyCproject/src + Other refactorings that

are planned:

Extract Function

Hide Member Function

Move Field or Member Function
Extract Subclass

Extract Baseclass

Separate Class

Implement Function

Declare Function

Move Function Definition
Generate Getters and Setters

|l MyCproject.c

Original Source Refactored Source
#include <stdio.h> #include <stdlib.h>
#include <stdlib.h>

__—{static const float MYZERO = 9.9;

int main(void) { [int main(void) {
double intvalu double intvalue=MYZERO;
puts("!11Hello WO™Td!!!"); /* prints | puts("!11Hello World!!!"); /* prin
return EXIT_SUCCESS; return EXIT_SUCCESS;

} }

int foo(){ int foo(){
double myin double myint-MYZERO;

+H P H o+

O Finish )

Module 7 PTP Tutorial
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Language-Based Searching

+ “Knows” what things can
be declared in each
language (functions,
variables, classes,
modules, etc.)

Searc
JII

- Search

h | Project Window
Search... Ctrl+H
File...

Text

C/C++...

Fortran...

7 File Search | % C/C++ Search | E5” Fortrap@@8rch | 27 Java Search | %57 Plug-in Search

;
Search string (* = any string, ? = any character):
get” Case sensitive

Search For Limit To

Class / Struct | V| Function Variable Declarations Definitions

Union V| Method Field V| References All Occurrences

Enumeration Enumerator Namespace

Typedef Macro Any Element

- Search

+ E.g., search for every call
to a function whose name
starts with “get”

+ Search can be project- or
workspace-wide

get”

" File Search

Search pattern:

Search for

Common block |V|Function

€ C/C++ Search | Fy Fortran Search |12 Java Search | ™5 Plug-in Search

Regular expression

(* = any string, 7 = any character)

Limit to

All occurrences

Scope

@ Workspace Selected resources Enclosing projects

Working set:

.'_? Tmi;e... . Search | ‘

Module 7

V| Subroutine

Variable

Scope
@ Workspace

Working set

Module

Program

Selected resources

‘;) l Customize...

Declarations

@ References

Enclosing projects

PTP Tutorial
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Open Declaration

] gauselim.f90 2
Jumps to the declaration
of a variable, function, )
etc-/ even if it'sin a write (*, *) 'A Matrix:'
different file call mexrd (pmes——oio i

call mtxwrt

Right-click on an identifier writh (*,

Click Open Declaration write (%, *
call vctrd( Open Declaration F3

call vctwrt Frgeals \ Alt+Shift+W »

Tip: Open Declaration works
in C/C++, and it works in
Fortran, but it cannot jump
“across languages”

PTP Tutorial
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Parallel Lang. Dev. Tools

+ PLDT Features

+ Analysis of C and C++ code to determine the location
of MPI, OpenMP, and UPC Artifacts

+ Content assist via ctrl+space ("completion™)

+ Hover help

+ Reference information about the API calls via Dynamic
Help

+ New project wizard automatically configures managed
build projects for MPI & OpenMP

+ OpenMP problems view of common errors

+ OpenMP “show #pragma region”, “"show concurrency’

+ MPI Barrier analysis - detects potential deadlocks

(4

Some MPI features were covered in Module 4

Module 7
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OpenMP Managed Build Project

+ If you haven't set up
OpenMP preferences e.q.
include file location, do it
now

+ Create a new OpenMP
project
File» New»C Project

Name the project e.g.
‘MyOpenMPproject’

Select OpenMP Hello World C
Project

Select Next, then fill in other
info like MPI project

Module 7

C Project

Create C project of selected type

Project name: MyOpenMPproject

Use default location

Location: |/home/tibbitts/ews/runtime-pldt20/MyMPIproject

Project types: Toolchain:
® Hello World C++ Project
@ Hello World ANSI C Project
@ Empty Project
® MPI Hello World C Project
@ MPI Empty C Project
® OpenMP Hello World C Proj
@ OpenMP Empty C Project
(=>Shared Library
(= Static Library [~
Gl

Show project types and toolchains only if they are supported on the platform

)

|

au ‘—:‘\\
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Setting OpenMP Special |
Build Options

= Properties for MyOpenMPproject

+ OpenMP typically requires |[FEE= settings

Resource

special compiler options. s I =
+ Open the project s b

Zeiii & Tool settings | # puild steps Build artifact | a9 Binary parsers | @

I Tool chain editor
p rO p e rtl e S ‘v’ariablesl =~ B0

) Other flags | -c -fmessage-length=
+- C/C++ General

+ S e | eCt C / C + + B u i I d Project References S ) ) [Jverbose (-v)

Refactoring History []support ANSI programs (-ansi)
Run/Debug Settings

+ Select Settings
+ Select C Compiler

+In Miscellaneous,
add option(s).

& Shared Library Se

Module 7
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¥ Show MPI Artifacts

¥ Show OpenMP Artifacts
#7) MPI Barrier Analysis

()DE oA >

= C/C++ - MyOpenMPproject/src/MyOpenMPproject.c - Eclipse SDK - C:\ews\runtime-temp

l=Jojes

File Edit Refactor Navigate Search Project Run Window Help

G~ eiv @~
77/ ¥o oo

$-0-Q- 0"

L

NI = | )
> S

L5 Project Explorer &3 = O || [g) *mMyopenMPproject.c &2

= double *x, *y; =

— o
=

=125 MyMPIproject
#-[a} Incudes
#-( src >
+-(= Debug

= g;;;c MyOpenMPproject
#-[m}}) Incdudes ' o) T
2 src R

+- €| MyOpenMPproject.c

+-(= Debug

arraySize ¥
arraySize ¥

X = (double

malloc( (size t) (
Yy = (double * ( t (

malloc (

F %5 Debug |G cjc++ |8 Java

= E Ou o ))1 (=} E

B R o
S stdio.h
™ string.h
o stdib.h
= math.h
= openmp.h
@ main(int, char

= ~

sizeof (do
sizeof (do

* Here's he for-1 (=]
’ #pragma omp p
for (1 = 0; i < arraySize; i++ )
{ o
v[i] = sin( exp( cos( - exp( sin(x[i]) ) ) ) ):
}
return 0;
}
v
< > < >
[ _Problems | /-] Tasks. Sl Consolautinahupsautpentmsmrosiell § OpeniP Artifact View ©3 =g
i X7
OpenMP Artifact Filename LineNo Co
# omp_in_parallel MyOpenMPproject.c 26 Fur
#pragma omp parallel for MyOpenMPproject.c 34 Opt
>
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- ‘.:‘\\

Show Pragma Region

Run OpenMP

analysis B sorams omp pazenier or
R|ght CIle On fo:‘ (i=0; i < arraySize; i++ )
pragma in .
artifact view e

<

v[i] = sin( exp( cos( - exp( sin(x[1]) ) ) ) )’

|2 Problems | v Tasks | E] Console | %f Debug | ‘@ OpenMP Problems | §9» OpenMP Artifact View £33

Se l ect S h ow OpenMP Artifact Filename LineNo
p ra g m a reg I o N omp_in_parallel MyOpenMPproject.c 26

T T pject.c 34
Show pragma region

See highlighted region in C editor

Module 7
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Show OpenMP Problems

+ Select OpenMP
problems view

+ Will identify standard
OpenMP restrictions

Module 7

< C/C++ - MyOpenMPproject/src/openMPproblems.c - Eclipse SDK - C:\ews\runtime-temp

BE]

File Edit Refactor

ST '\_E_[' a9 ¢ &~

4

L Project Explorer &2

4 |.c| MyOpenMPprd

+|.c| openMPproblems.c

+ (% Debug

Navigate Search Project Run

= O/ [.g] *MyOpenMPproject.c

Window Help

/- B~
&8 : wl~ %

Y %5 Debug

> ¥o O Bg c/c++ faq’aj Java

.| openMPproblems.c &3

#pragma omp parallel for
for(j=1; j<10; j++)

}
void barriercheck4 ()

int 1, 3;

{2 Problems | | Tasks | E] Console | @ OpenMP Problems 52 . §P» OpenMP Artifact View

Description
& For directive embedded within another parallel for or parallel sections
& Barrier directive not permitted in region extent of for, ordered, sections, single, master, and critical

Writable Smart Insert 26:5

opt
opr
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Show Concurrency

Highlight a statement

Select the context menu
on the highlighted
statement, and click
Show concurrency

Other statements will be
highlighted in yellow

The yellow highlighted
statements might execute
concurrently to the
selected statement

Module 7
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UPC Support

To see UPC support in C :
editor, install the optional Under Optional Features

feature from CDT

See Also:
http://wiki.eclipse.org/PTP/other_tools_setup#Using_UPC_features

c(MatrixMulti.upc 53

Filetypes of “upc” will ~TT // private variables
get UPC syntax high- T —

lighting, content assist, i-0; %<N; i++; &a[i][01)
J=495 J<r; J++
etc. ali][j]=1*P+j+1;

<! 4= Unified Parallel C Support

Use preferences to o
* // intialize the matrix b[][]
change default for *.c upc_forall(j=0; j<M; j++; &b[BI[31)

if you like for (i=0; i<P; i+4)
b[1][3]=3%2;

Module 7




paratel—toois—platiform
Remote Development

+ PTP already provides the ability to launch/debug
remotely
+ However it is often desirable to be able to edit and build remotely
+ If projects are very large, build times may be considerable

+ The PTP Remote Development Tools (RDT) will provide
a complete remote development environment

C/C++ (and Fortran) projects can be hosted on a remote machine

Eclipse runs on your local workstation or laptop

Files are pulled to local machine only for editing

Remote indexing and other services are performed remotely

Both managed and Makefile projects are built remotely

Uses either Remote System Explorer (RSE) or PTP’s Remote Tools

Will have the ability to tunnel over ssh connections

+
+
+
+
+
+
+

Module 7
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Remote Development (2)

+ RDT was introduced with PTP 2.1
+ Configuration is separate from PTP configuration
+ Restricted to RSE connections only (no tunneling)
+ Manual server launch
+ PTP 3.0 will seamlessly integrate RDT configuration and
simplify setup and use
+ New service model combines PTP and RDT configuration
+ New project wizard has been enhanced and simplified
+ Automatically launch remote server process
+ Still under active development

So we won't cover it today

Module 7
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Module 8: Other Tools and
Wrap-up

+ Objective
+ How to find more information on PTP
+ Learn about other tools related to PTP
+ See PTP upcoming features

+ Contents

+ Links to other tools, including performance tools
+ Planned features for new versions of PTP

+ Additional documentation

+ How to get involved




paratel—toois—platiform

NCSA
HPC Workbench

+ Tools for NCSA Blue Waters
*
+ Sustained Petaflop system

+ Based on Eclipse and PTP
+ Includes some related tools
+ Performance tools

+ Scalable debugger
+ Workflow tools (https://wiki.ncsa.uiuc.edu/
display/MRDPUB/MRD+Public+Space+Home
+Page)
+ Part of the enhanced computational environment

described at:
http://www.ncsa.illinois.edu/BlueWaters/ece.htmi
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s NCSA HPC Work

(CDT, PLDT, Launching &

S » | Monitoring

=T

SHARED, BT DLE
ALLOCATED TO SOVES

08RG E specte 7 sulder Tragerperspetve 7 s Parspecte
PrED ]

FEEERBRKIEL

RO /e

G Fortran

e R e P o

_modute pat:
Anpuicit non

type to hold data poin
Aixedform t(4,1000)

fortran-and-c n(a)

elmination n(a)

sodule
progran BstritPro;

© use maataset

© Make Targets 5 Problems 12 Console Properties

ertors, 0 warmings, 0 infos

T Debug - main - el SDE
Dty PP Rt

bs View \"

Current
Process Set—r——— — —

Performance CEE |
Tuning s

(HPC toolkit,

HPCS toolkit,
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PTP-Related Tools

+ External Tools Framework
+ Formerly Performance Tools Framework

+ Tuning and Analysis Utilities (TAU)

+ ISP - In-situ Partial Ordering
+ MPI analysis tools from U.Utah
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PTP/External Tools Framework

formerly “Performance Tools Framework”

—<tool name="Valgrind">
—<execute>

G oa I : <utility command="bash" group="inbin"/>

—<utility command="valgrind" group="valgrind">
—<optionpane title="Val d" seperatewith="">

W - 1 144 i ="Le eck” ="-leak-check=full" i
+ Reduce the “eclipse plumbing e Etion abelo Show Beschates, e o st

</optionpane>

necessary to integrate tools e

</tool>

+ Provide integration for
instrumentation, measurement, and | =
analysis for a variety of performance
tools

+ Dynamic Tool Definitions:
Workflows & Ul

+ Tools and tool workflows are
specified in an XML file r?grar?ﬁs;;omvj\thmEcllpsevwathePTP.

‘type filter text ‘

+ Tools are selected and configured in |
the launch configuration window ]| I —

+ Output is generated, managed and sl —
analyzed as specified in the
workflow

Module 8
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PTP TAU plug-ins .

WwWw.cs.uoregon.edu/research/tau/home.php

TAU (Tuning and Analysis Utilities)
First implementation of Performance Tools Framework

Eclipse plug-ins wrap TAU functions, make them
available from Eclipse

Compatible with Photran and CDT projects and with
PTP parallel application launching

Other plug-ins launch Paraprof from Eclipse too
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ISP - In-situ Partial Order
= ===

+ Being contributed to PTP by U. Utah
+ Hope to make available in PTP 3.0 (late Oct.)

+ Analyses MPI code dynamically for deadlocks, etc.
+ Can match sends and recieves

+ Can work with several different MPI
implementations
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ISP - Formal Dynamic Verification of MPI
~Applications

Verifies MPI User Applications, generating
only the Relevant Process Interleavings

066G R

0 6

L )
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[
S
1 2
»
[
>
12
[

A

(Image courtesy of Steve Parker, U of Utah)
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Eclipse CDT/PTP based ISP GUI ==

ISP Plug-in (trident icon) based on CDT and PTP

allows PostVerification Review of

Relevant Interleavings, and highlights bug

aven

ISP Analyzer & |1/ ISP Conscle

Transition: 8/11
| | No Ranks Locked | v

Detailed Runtime information

Deadlock in intereaving 2
esource |eak

Code Windows

Rank: 1
File: MPI_POE Jllustration. ¢ Line: S0
MPI_Recv (bufl, buf_size, MPIINT, 2, 0, MPI_COMM_WORLD, status)
+[ Originating Call
else if rank == 1/ {
m‘\_ll'l‘rv‘m.fl‘ !'hf__’-l?l‘, MEIINT. MPI_ANY
MPI_Barrier (M?|_COMM_WORLD)
MPI_Recv (bufl, buf_size, MPI_INT. 2, 0, MPI_COMM_WORLD, &status),

MPI_Barrier (MP1_COMM_WORLD);
memset (bufo, 0. buf_size);
MPI_Isend|bufo, buf_size, MPIINT, 1, 0, MPI_COMM_WORLD, &req
MPI Waiti&req, &status);
}
MPI_Analize (),
printf (*(%¢| finished normally\n®, rank)

return 1

MEOF Y/

Interleaving: 1/2

Rank: 2
Fle: MPI_POE lustration.c Line; 56
MPI_Isend(bufo, buf_sze, MPI_INT. 1, 0, MPI_COMM_WORLD, req):

=+ Matching Calls

MPI_Barrl _
MPI_Recv [bufl, buf_size, MPLINT, 2, 0, MPI_COMM_WORLD, &status),
MPI Viaiti&req. &status):

else if (rank == 21 {
MPI_Barrier (MPI_COMM_WORLD);
memset (bufD, 0. buf_size):
MPI_lsend(bufa. buf_size, MPI_INT, 1, 0, MPI_COMM_WORLD, &req);
MPI Waiti&req, &status)
}
MP1_Rnalize ();

printf (5] Finished normallyin®, renk);

retum 1

It also allows viewing of MPI
Happens-Before Relation - a
succinct summary of the
required MPI orderings

i

Switch Interleavings

Showing Interleaving: 1/2

For details, including Beta download, please visit
http://www.cs.utah.edu/formal_verification/ISP-Eclipse
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Useful Eclipse Tools

+ Python
+ http://pydev.sourceforge.net

+ Ruby
+ http://sourceforge.net/projects/rubyeclipse

+ Subversion (now an Eclipse project)
+ http://eclipse.org/subversive

+ Git (now an Eclipse project)
+ http://www.eclipse.org/egit

+ ... and many more!
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Future PTP Features

+ Support for multicore development
+ Building on Cell IDE and other multicore tools

+ Resource managers to support for PBS, LSF,
and Blue Gene

+ Transitioning debugger to Scalable Tools
Communication Infrastructure (STCI)

+ Enhancements to ETF to support compiler
generated reports and optimization directives
+ Scalability improvements
+ UI to support 1M processes
+ Optimized communication protocol
+ Very large application support

Module 8
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Information About PTP

+ Main web site for downloads, documentation, etc.
+ http://eclipse.org/ptp

+ Developers’ wiki for designs, planning, meetings, etc.
+ http://wiki.eclipse.org/PTP

+ Articles and other documents:
+ http://wiki.eclipse.org/PTP/articles
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Mailing Lists

+ PTP Mailing lists

+ Major announcements (new releases, etc.) - low volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-announce

+ User discussion and queries - medium volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-user

+ Developer discussions - high volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-dev

+ Photran Mailing lists
+ User discussion and queries
+ http://dev.eclipse.org/mailman/listinfo/photran

+ Developer discussions -
+ http://dev.eclipse.org/mailman/listinfo/photran-dev
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Getting Involved

+ See http://eclipse.org/ptp
+ Read the developer documentation on the wiki
+ Join the mailing lists

+ Attend the monthly developer meetings
+ Teleconference each second Tuesday, 1:00 pm ET

+ PTP will only succeed with your participation!
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PTP Tutorial Feedback

+ Please complete feedback form
+ Your feedback is valuable!

Thanks for attending
We hope you found it useful
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